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1. PRESENTATION

Grattis! Du har kopt ett avancerat traningsverktyg med en méngd funktioner som du kan anvanda for att
skraddarsy din traning efter dina personliga nskemal och behov. | denna bruksanvisning finns
instruktioner for hur du far ut s& mycket som mojligt av din cykeldator.

KOMPLETT TRANINGSSYSTEM

Planera din traning med Polar
ProTrainer 5. Fiir dver planerna till
cykeldatorn.

Se detaljerad information om
dintraning. Lagra din
traningsdata fir analys av en
ldngre traningsperiod i Polar
ProTrainer 5.

Din cykeldator hjdlper dig
genom traningen och registrerar
dina trdningsdata. Efter
traningen fir du dver dina data
till Polar ProTrainer 5.

Den senaste versionen av denna anvandarhandbok kan laddas ner fran http://www.polar.com/support. For
videohandledning, ga till http://www.polar.com/en/support/video_tutorials.

Presentation 5
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2. KOMPONENTER FOR CYKELDATOR

5

1 H3 pulssensor/

Wearlink+ sandarbalte W.I.N.D. polarpersonaltrainer.com
2 G5/G3 GPS-sensor IDA USB-adapter
WebLink
3 CS kadenssensor W.IN.D.
4 CS hastighetssensor W.LN.D. ProTrainer 5
5 KéoPower/ IrDA USB-adapter

Power Output Sensor W.LN.D.

e Polar CS600X cykeldator: registrerar och visar cykel- och traningsdata under tréning.

e Polar H3 pulssensor: bestar av sdndare och elektrodbalte och skickar pulssignalen till cykeldatorn.

e Polar Bike Mount™: Montera styrfastet pa cykeln och satt fast cykeldatorn pa den.

e Polar Speed Sensor™ W.I.N.D.: méater hastighet och stracka vid cykling.

e CD-ROM: inkluderar Polar Protrainer 5™ och en fullstandig bruksanvisning som hjalper dig att fa ut mesta
mojliga av din cykeldator.

Med programvaran Polar ProTrainer 5 kan du planera din traning i férvag med flera planeringsalternativ
och o6verfora instéllningarna till din Polar-produkt. Efter traningen kan du analysera resultaten med
avancerade diagram som du kan anpassa efter dina behov.

Du kan aven éverféra dina traningsdata till webbtjansten polarpersonaltrainer.com.
Polarpersonaltrainer.com ar din online-traningsdagbok och interaktiva tranings-community som haller dig
motiverad.

Tillbehor

e Polar Speed Sensor™ W.I.N.D.: méater hastighet och stréacka vid cykling.

e Cadence Sensor™ W.I.N.D.: Méater trampfrekvensen (kadensen) pa pedalarmen nér du cyklar, métt i varv
per minut (rpm).

e Systemet Polar LOOK Kéo Power: mater genomsnittlig och maximal kadens, effekt och pedalindex samt
balansen mellan vanster och hoger pedal.

e Polar G5 GPS sensor™: Méter hastighet/tempo, stracka och position (koordinater) vid alla
utomhusaktiviteter genom att anvanda GPS (Global Positioning System)-teknologi. Overfér dina
positionsdata till programvaran Polar ProTrainer 5 for att granska din traningsrutt i Google Earth eller
konvertera dem till en GPX-fil (fér dverforing till externt kartprogram). Mer information finns i programmets
Hjalp-funktion.

@ Nér du anvander Polar G5 GPS-sensor och en hastighetssensor fdr cykel samtidigt, kommer GPS:en endast att
anvéndas for bestamning av position och lagring av koordinater. Om cykelhastighetssensor inte dr inom

6 Komponenter for cykeldator
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mottagningsradien (t.ex. om olika sporter utfors under ett traningspass) far cykeldatorn information om hastighet
och distans fran GPS-sensorn. P4 sa vis garanteras alltid métning av hastighet och strdcka under traningspasset
om GPS-sensorn anvénds. Om du under pagaende traning vill borja ansluta cykelhastighetssensorn igen trycker du
och haller in LIGHT och véljer Seek sensov (Sk sensor).

Komponenter for cykeldator 7
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3. KOMMA IGANG

For videohandledning, ga till http://www.polar.com/en/support/video_tutorials.

Mat cykelhjulens storlek innan du bérjar anvanda din cykeldator.

Mata hjulstorleken

Installning av hjulstorleken ar nodvandig for att fa korrekt cykeldata. Det finns tva satt att bestdmma
cykelns hjulstorlek:

Metod 1

Sok efter diametern i tum eller ETRTO som finns tryckt pa hjulet. Omvandla det till hjulets storlek i
millimeter i den hoégra tabellkolumnen.

ETRTO Hjulets diameter (inch/tum) Hjulstorleksinstallning (mm)
25-559 26x1,0 1884
23-571 650 x 23C 1909
35-559 26x 1,50 1947
37-622 700 x 35C 1958
47-559 26x1,95 2022
20-622 700 x 20C 2051
52-559 26x2,0 2054
23-622 700 x 23C 2070
25-622 700 x 25C 2080
28-622 700x 28 2101
32-622 700 x 32C 2126
42-622 700 x 40C 2189
47-622 700 x47C 2220
55-622 29x2.2 2282
55-584 27.5x%2.2 2124

Installningar for hjulstorlek i tabellen &r endast till som vagledning eftersom hjulets omkrets beror pa hjultyp och
lufttryck.

Metod 2

Mat hjulets omkrets manuellt for att fa basta resultat.

Anvand ventilen for att markera laget dar hjulet rér vid marken. Dra en linje pa marken for att markera den
punkten. Kor din cykel framat pa jamnt underlag sa att hjulet roterar ett helt varv. Dacket bor vara
vinkelratt mot marken. Rita ett nytt streck pa marken for att markera ett helt varv. Méat avstandet mellan
de tva strecken.

Dra av 4 mm fran detta matt for att eliminera effekten av din egen vikt sa far du hjulets omkrets. For in
detta varde i cykeldatorn.

8 Komma igang
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Grundinstillningar

Anpassa grundlaggande installningar innan du anvander cykeldatorn for forsta gangen. Ange sa exakta
uppgifter som mojligt for att fa korrekt feedback baserat pa din prestanda.

INFRARGTT

/ _ UP (UPP)

Ié':ylf (LYSE) \ Bléddra_mel.!an
X altemativ / dka
display { vérden
- W

STOPP \ DOWN (NER)

Atergar till Bl4ddra mellan

firegdende altemnativ/ minska

display. ‘ vérden.

0K
Godkénn val

Justera uppgifterna med hjalp av knapparna UP, DOWN och acceptera med OK: Vardena bladdrar
snabbare om du héller in knappen UP eller DOWN.

1.

o~ W

O N>

Aktivera din cykeldator genom att trycka pa OK tva ganger. Nar du en gang har aktiverat den kan du inte
stanga av den!

Polar-logotypen visas. Tryck pa OK.
Language (Sprak): Valj English, Deutsch, Espaiiol, Francgais eller Italiano. Tryck pa OK.
Start with bike settings (Borja med cykelinstéllningarna) visas. Tryck pa OK.

Antal cyklar: Valj 1 eller 2 beroende pa hur manga cyklar du vill anvdnda. Om du endast anvander en
cykel kan du ange installningarna for cyklarna 2 och 3 senare. Mer information finns i Cykelinstaliningar
(Bike Set) (sida 37).

Wheel (Hjul): Ange hjulstorlek [mm) for alla cyklar. Mer information finns i Mata hjulstorleken (sida 8).
Start with basic settings (Borja med grundinstallningarna) visas. Tryck OK och justera féljande data:
Time (Tid): Valj 12- eller 24-timmarstid. For 12-timmarstid, valj At (Fm) eller P (Em). Ange lokaltid.

Date (Datum): For in aktuellt datum, dd = dag, mm = manad, yy = &r. Om du anvander 12-timmarslage
staller du in datum enligt mm = manad, dd = dag, yy = ar.

. Units (Enheter): Valj metriska (kg-cm.~km) eller engelsk/amerikanska (lb.~Ft.-mi) enheter.
11.
12.
13.
14.
15.

Weight (Vikt): Ange din vikt. For att andra enheter, tryck och hall in LIGHT.
Height (Langd): Ange din langd. | LB/FT format, skriv forst in fot och sedan tum.
Birthday (Fodelsedag): For in dina fédelsedata; dd=dag, mm=manad, yy=ar

Sex (Kon): Valj male (Man) eller Female (Kvinna).

Settings 0K? visas. Valj Yes (Ja) eller No (Nej). Valj Yes (Ja) for att godkanna och spara installningarna.
Cykeldatorn kommer att visa en klocka. Valj No (Nej) om installningarna ar felaktiga och ska andras. Tryck
pa STOP for att aterga till de uppgifter du vill andra.

Komma igang 9
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Menystruktur

Menyn visas nar du Today
gverfirt programmerade & T
triningspass fréan i =
programvaran till
cykeldatorn.

1Dagens trdning

3 Traningsprogram

. Exerciselog

i (Traningslogg)

File ¥ Weekly (Per vecka)
1| Totals (Totalvarden)

Fér att bladdra i menyn, Delete (Radera)
tryck pa UP (upp)och | "
DOWN (ner).

Exercise
po— (Traningspass)

Settinss Tl Fpature
i & (Funktioner)
Man 12.06. Bike (Cykel)

j =/ User (Anvandare)

General (Allmant)
—————— Watch (Klocka)

g _.,...o’o-“l Konditionstest

Optimizer

For att dtergd till visning )
av klocka, tryck och héll Connect 1) Lﬂfrarod_k _
STOP-knappen intryckt. @"""@a ommunikation

\E__L_-J

4o—|

Montera Polar styrfaste

Du kan montera styrfastet och cykeldatorn pa vanster eller hoger sida av styret, eller pa styrtappen.

1. Placera gummidelen pa styret och satt styrfastet ovanpa.

2. Sé&tt kabelbanden Gver styrfastet och justera dem runt styret. Drag at banden ordentligt. Skar av
eventuella andar fran kabelbanden som blir Gver.

10 Komma igang
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Fasta cykeldatorn pa styrfastet
1) Placera cykeldatorn pa styrfastet ("klockan 10"). Vrid cykeldatorn medurs till du hor ett klickljud.

2) Lossa cykeldatorn genom att trycka ner den och samtidigt vrida den moturs.

Komma igang 11
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4. FORBEREDELSER INFOR TRANING

Planera din traning

Traningstyper

Du kan anvanda de fardiga traningsprogrammen eller skapa nya pa din cykeldator. Du kan ocksa planera
och skapa mer avancerade traningspass och sedan féra 6ver dem till din cykeldator med programmet Polar
ProTrainer 5 . Mer information om 6verféring finns i Traningsprogram (sida 44).

Vélj Settings (Instaliningar) > Exercise (Tréning)

» Exercice
Features =

Settinss T

| Exercises visas en lista med olika typer av traningspass.

Bladdra genom alternativen med UP eller DOWN

Exercices
» Free

Basic -

e Free (Fri): traning utan forinstaliningar
e Basic (Grundlaggande): Grundlaggande medelintensiv tréning. Rekommenderad varaktighet c:a 45 min.

e 0OwnZone: Grundlaggande medelintensivt traningspass baserat pa OwnZone. Cykeldatorn kan automatiskt
faststélla din personliga pulszon fér aerob tréning (férbattrad kondition). Det kallas din OwnZone.
Foreslagen varaktighet 45 minuter. Mer information finns i Faststélla din OwnZone (sida 23). Mer
bakgrundsinformation finns i OwnZone-tréning (sida 58).

¢ Intervall: Passet inleds med 15 minuters uppvarmning, foljt av en intervall pa 5 km med 5 minuters
aterhamtningsperiod. Detta upprepas 3 ganger Passet avslutas med nedvarvning i 15 minuter.

e Add new (L&gg till ny): Skapa och spara ditt eget traningspass. Du kan lagra totalt 10 férprogrammerade
pass + 1 Fri tréaning i din cykeldator.

Nar du har valt 6nskat traningspass (Free, Basic, OwnZone, Interval eller Add new) visas féljande
alternativ. Valj d6nskat alternativ och tryck OK.

1. Select (Valj) passet som standardpass. Nasta gang du trénar visas detta pass som standard.
2. View (Visa) traningsinstallningarna. Bladdra UP eller DOWN for att se:

a. Tranai 1-3 traningszoner baserat pa din puls, hastighet/kadens*/effekt* for varje zon samt
tid/stracka for resp. zon eller

b. Tréna med faser: namn, beskrivning, maltraningstid. (Tryck och hall in LIGHT for att se
traningsfaserna och vald sportprofil.)

3. Edit (Redigera) grundlaggande eller OwnZone-traning for att passa dina behov. Du kan ocksa redigera ett
pass som skapats med cykeldatorn. Se Skapa nya traningspass med cykeldatorn fér mer information. Om
du skapat ett traningsprogram med faser med Polar ProTrainer 5 gar det inte att redigera dem i
cykeldatorn.

4. Rename (D6p om) Grundlaggande eller Intervall eller annan traning som skapats med cykeldatorn.

5. Default (Standard) Aterga till standardinstaliningarna for Grundlaggande, intervall- eller
OwnZone-tréning.

6. Delete (Radera) tréning som du har skapat med cykeldatorn eller programmet Polar ProTrainer 5.

* Extra sensor kravs.

12 Forberedelser infor traning



SVENSKA

Skapa nya traningspass med cykeldatorn.
Skapa ett nytt trdningspass med traningszoner

Skapa egna tréaningspass med cykeldatorn.

G4 till Settings > Exercises > Add new

1. Stall in antal zoner for passe (0-3) och tryck OK. Se dven Skapa ett nytt tréningspass utan zoner.
2. Valj zontyp:

A. Heart rate (puls)

B. Speed (hastighet)

C. Cadence* (kadens)

D. Power* (effekt)

Tryck pa OK.

A. Val sportzon for puls eller Manual for att ange pulszon manuellt. Tryck pa OK.

e Sport zone (Sportzoner): valj en sportzon (t.ex. Z1: 50-59 % av maxpuls) for ditt pass. Tryck OK for att
fortsatta till steg 3.

Polar sportzoner ar pulsintensitet uttryckt i procent av din maxpuls. Fem olika sportzoner ar installda i
cykeldatorn som standard: wery light (mycket 14tt) (50-59 % av maxpuls), light (1att) (60-69 % av
maxpuls), moderate (medel) (70-79 % av maxpuls), hard (hard) (80-89 % av maxpuls), and maximum
(max) (90-99 % av maxpuls). Standardvardet fér maxpuls ar aldersbaserat, men om du vet dina exakta
aeroba och anaeroba trosklar och har métt din berdknade maxpuls (HRax -P) i ett Polar Fitness Test™,
testat fram din maxpuls sjalv eller i ett testlab kan du stall in sportzonerna sa att de passar dina
traningsbehov.

e Manual (Manuellt): Stall in den 6vre och nedre gransen i slag/minut eller i procent av maxpuls (HR%)/
procent av din pulsreserv (HRR%) och tryck OK fér att fortsatta till steg 3.

B. Om du véljer speed (hastighets-), cadence *(kadens-) eller power * zones (effektzoner) skall du stalla in
ovre och nedre zongranser. Tryck OK for att fortsatta till steg 3.

e Om du véljer kadens som zon, visas grénserna i varv per minut (rpm).
e Om du valjer effekt som en zontyp anges granserna i watt.

3. Stall in Zone guide for byte av zon efter en angiven tid eller stracka*. Under traningen kommer
cykeldatorn att tala om néar du skall byta zon

e Timers: Stall in en timer fér zonen (minuter och sekunder) och tryck OK.
e Distances: Stall in strackan fér zonen och tryck OK
e DFF (Av): Avaktivera timer och strackor* och tryck OK.

Nar du stallt in den forsta zonen visas Zone 1 OK. F6r mer an en zon, upprepa steg 2 och 3 tills du stallt in
alla zoner.

Néar traningspasset ar klart visas New exercise added (nytt pass har lagts till). Det nya passet (NewExe)
lagras i menyn Exercises, dar du kan valja det nasta gadng du tranar. D6p om passet genom att vélja
Rename (dép om) i listan.

Skapa ett nytt traningspass utan traningszoner

Om du skapar ett nytt traningspass utan zoner kan du anvanda timers eller strackor fér att styra din
tréning.
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Valj Settings (Installningar) > Exercises (Traning) > Add new (Lagg till ny)

1. Number of zones (Antal zoner): Stall in antalet zoner till O.

2. Guide type (Guidetyp): Valj mellan en timer som ljuder under passet (for att paminna dig om att dricka,
t.ex. ), eller stéll in en strécka (For att kolla varvtiderna utan att lagra dem).

Timers

e Number of timers (Antal timers): Valj antalet timers (1-3) for passet. Tryck pa OK.
e Timer 1 (Timer 1): Stall in minuter och sekunder foér timern och tryck OK.

Strackor

e Number of distances (Antal strackor): Valj antalet strackor (1-3) for passet. Tryck pa OK.
e Distance 1 (Stracka 1): Ange strackan och tryck OK.

Upprepa steg 2 tills du stallt in dnskat antal timers eller strackor. Nar traningspasset ar klart visas New
exercise added (nytt pass har lagts till). Det nya passet (NewEx=e) lagras i menyn Exercises, dar du kan
vélja det nasta gang du tranar. D6p om passet genom att valja Rename (d6p om) i listan.

* Extra sensor kravs.

Skapa nya traningspass med Polar ProTrainer 5
Du kan skapa mer avancerade traningspass med Polar ProTrainer 5. Mer information finns i Hjalpen till
Polar ProTrainer 5.

Tag pa dig pulssensorn

Tag pa dig pulssensorn for att mata din puls.

.

1. Fukta baltets elektrodytor.

@ Vid ldnga traningspass rekommenderar vi att du anvénder elektrodgel for att forbattra kontakten. Efter
traningen maste pulssensorn tvattas noggrant.

2. Fast sandaren pa baltet.

w

Bar séandarbaltet runt bréstkorgen, precis under bréstmusklerna, och fast haken i béltets andra dnda.

4. Justera baltets l1angd sa att det sitter &t men fortfarande ar bekvamt. Fukta huden dar elektrodytorna har
kontakt mot kroppen. Kontrollera att elektrodytorna ligger dikt an mot huden och att Polarlogotypen pa
sandaren &r mitt fram och i uppréatt lage.

@ Lossa sédndaren fran béltet efter varje anvandning for att maximera sandarbatteriets livslangd. Svett och fukt kan
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halla elektroderna fuktiga och séndaren aktiverad. Detta minskar batteriets livslangd. Fér ndrmare instruktioner
om tvéitt, se Skétsel och underhéll (sida 61).

For videohandledning, ga till http://www.polar.com/en/polar_community/videos.

@ Polar H3 pulssensor kan anvdndas med sérskilda klddesplagg som har insydda textilelektroder. Fukta plaggets
elektrodytor med vatten. Klicka fast pulssensorns sandarenhet pa tryckknapparna direkt pa plagget sa att
séndarens Polar-logotyp sitter rattvand.

Forberedelser infor traning 15
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5. TRANING

Borja trana

Tag pa dig pulssensorn och montera cykeldatorn pa styrfastet.

1.
2.

4.

Starta pulsmatningen genom att trycka pa OK-knappen. Cykeldatorn Gvergar till standby-lage.

Valj den cykel du ska trdna med. Cykel 1 ar forvald. Valj Settings (Instaliningar) > Bike (Cykel) > Bike 1
(Cykel 1)/ Bike 2 (Cykel 2)/ Bike 3 (Cykel 3) > OK. Valj Other (Ovrigt) for att méata endast puls, héjd,
temperatur och data som genereras av GPS-sensorn.

Select
» Bike 1
Bike 2

-
o
+— o

@ Siffran langst ned i hogra hérnet anger den cykel som ska anvéndas. Byt cykel snabbt genom att trycka pa
och héalla in DOWN. Fir att byta traningspass, tryck och hall in UP.

@ Endast de cyklar som &r aktiverade (ON) visas i listan. For ytterligare information, se Cykelinstéliningar
(Bike Set) (sida 37).

Inom fyra sekunder visas din puls pa displayen. Den hjartformade ramen runt hjartsymbolen visar att
sandningen ar kodad. Beroende pa vilken sensor du anvander blinkar symbolen for cyklisten eller GPS
(eller bada) langst ner i det vénstra hornet pa displayen tills alla sensorer har hittats.

Starta traningen genom att trycka pa OK. Typ av traningspass visas i det dvre vanstra hornet.

Alternativt vélj Settings (Instéliningar), Reset krip (Nollstall tripmataren) eller Location (Position).

| Settings (Installningar) kan du andra eller se olika installningar foére traningspasset. Mer information om
tillgéngliga instéllningar finns i Installningar (sida 34). Menyn Settings (Instaliningar) har féljande
alternativ:

Exercise (Traning): Valj Free (Fri), Basic (Grundlaggande), OwnZone eller Interval (Intervall) och tryck pa
OK (Om du har skapat nya traningspass kommer dessa ocksa att listas).

1. Select (Valj): Valj det traningspass som ska genomforas direkt eller
2. View (Visa): Visa tréaningsinstallningar.

6PS: Stall GPS-funktionen pa On/Off.

Altitude (H6jd): Kalibrera hojd.

Rec.rate: Stall in lagringsfrekvens.

RR data (RR-data): Sla pa/av R-R registreringen.

TZ Alarm: Sla pa/av ljud for alarmet for traningszonen.

HR view (Pulsformat): Valj mellan att visa pulsen i slag/minut eller i procent av maxpuls (HR%) eller i
procent av din pulsreserv (HRR%).

Bike (Cykelinformation): V&lj cykel 1, 2, 3 eller Other (Ovrigt).
A.Lap (Automatiska varvtider): SIa pa eller av funktionen fér automatisk lagring av varvtider.

Arr. time (Ank.tid): Stall in funktionen Ankomsttid pad On/Off och ange strackans langd. Om du har
funktionen R.Lap (Automatiska varvtider) pa anvands den ocksa for strackans langd.

Display: Andra displayinstallningar. Fér ytterligare information, se Gér personliga installningar pa
cykeldatorns display (sida 18).

| Reset trip (Nollstall tripmataren), kan du nollstélla tripméataren innan du startar ett tréningspass.

| Location** (Position) kan du kontrollera koordinaterna for din aktuella position. Traningsdatorn kommer
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att lokalisera din position genom att anvanda de senaste GPS-koordinaterna. Latitud och longitud uttrycks
i grader och minuter. Antalet satelliter GPS-sensorn har kontakt med visas pa den nedre raden.

@ Om du vill analysera positionsdata ytterligare, dverfér du informationen till Polar ProTrainer 5.

Héar ar nagra kortkommandon som du kan anvanda i traningspausmenyn:

e Tryck och hall in UP for att snabbt byta typ av traningspass. Som standard ar traningspasstypen Free.
e Tryck och hall in DOWN for att snabbt byta cykel.

e Tryck pad BACK for klocklage.

e Tryck och hall in LIGHT foér att se menyn for instaliningar.

@ Om du aktiverar funktionen Autostart pabdrjas och stoppas lagringen automatiskt i cykeldatorn nar du bérjar
respektive slutar cykla. Mer information om AutoStart finns | Cykelinstéllningar (Bike Set) (sida 37).
Cykeldatorn véljer automatiskt den cykel du anvénde vid férra traningspasset.

@ Om (Exercise name) requiresSpeed fadence */Power * oc/Exercise changed to Free (<Trdningsnamn>
kraver Hastighet/Kadens */Effekt* och Traningstyp dndrat till Free) visas maste ditt traningspass ha en sensor fir
att visa hastighets-/kadens-* eller effekt-*data. Se Cykelinstéliningar (Bike Set) (sida 37) for
anvisningar om hur du aktiverar sensorn férBike 1 /Bike 2 /Bike 3 (Cykel 1/Cykel 2/Cykel 3).

*Tillbehdrssensor kravs.

Information pa klockans display under traning

Din cykeldator visar 3 rader med information pa displayen under traningen. Genom att trycka UP eller
DOWN kan du se olika displayalternativ. Namnet pa displayalternativet visas i ett par sekunder. Namnet
indikerar vilken information som visas pa den nedre raden. Displayalternativen varierar beroende pa vilka
sensorer som du har installerat, vilka funktioner som har aktiverats och vilken slags traning du gor.

(@) Anpassa cykeldatorns display enkelt med programmet Polar ProTrainer 5.

Standardvyer pa displayen vid anvandning av hastighetssensor:

Speed [hastighet)
Aktuell puls
Tripmatare
Hastighet i km/h

Heart Rate [puls)
Forbrukade kalorier/timme
Tripmatare

Aktuell puls

Stopwatch [stoppur]
Snittpuls

Snitthastighet

Stoppur

Altitude [hijd]
Tid pé dygnet
Lutning

Hojd i meter

Traning 17
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6raph [grafer]

Pulsgraf

Hojdgraf

Stoppur (total traningstid hittills)

Zonelock [zonlas)
Nedréakningstimer
Zone pointer

Aktuell puls

Anpassa cykeldatorn sa att den visar den information som du vill se. Se Gor personliga installningar pa
cykeldatorns display (sida 18).

* Tillbehorssensorer kravs
Diagramvy

Med diagramvyn kan du jamfora tva varden i diagramform under traningspasset. Valj t.ex. ett diagram av
pulsen och hdjden.

Diagramvyn kan anpassas. Pa 6vre och mellersta raden kan du se effekt, hastighet, hisjjd eller puls som
diagram.

Gor personliga installningar pa cykeldatorns display
| klocklage, valj OK > Settings > Display > Edit.

Anpassa cykeldatorns display sa att den visar 6nskad information under traning. Du kan ocksa redigera
displayerna med programvaran Polar ProTrainer 5. Ett traningspass som har skapats i ProTrainer 5 har
egna displayinstallningar som inte kan andras direkt i cykeldatorn. Informationen pa displayen beror pa
vilka funktioner som aktiverats. Om exempelvis hastighetsmatningen inte &r aktiverad kan
hastighetsinformation inte visas i displayen.

Ytterligare information om symboler pa displayen finns i Symboler pa displayen (sida 19).

Valj det displayalternativ du vill &ndra genom att trycka pa UP eller DOWN, och tryck OK. Valj information
pa den blinkande oversta raden med UP eller DOWN och tryck OK.

Upprepa forfarandet for mellanraden och den nedersta raden. De olika displayerna ar uppkallade efter den
information som visas pa den nedre raden. For att aterstalla installningarna till displayens
standardinstallningar tryck och hall in LIGHT nér respektive rad blinkar.

Aktivera Titles for att se nament pa displayalternativet under traningen: | klocklage, valj OK > Settings >
Display > Titles

@ Displayinstéllningarna &r separata for var och en av cyklarna (cykel 1, 2, 3). Om du éndrar displayerna fér en cykel
kommer dndringarna inte att paverka instéllningarna for de andra cyklarna. Displayalternativen beror pa vilka
funktioner som har aktiverats. Mer information finns i Funktionsinstaliningar (sida 34) och
Cykelinstéliningar (Bike Set) (sida 37).
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Symbol Forklaring
£ Visar aktuell tid p3 dygnet
Gﬁ) Cykelsymbol
Nar de sensorer som skall anvéndas har identifierats slutar symbolen
blinka.
G G6PS-symbol
Nar de sensorer som skall anvdndas har identifierats slutar symbolen
blinka.
g Cykelnummer
Siffran i det nedersta hogra hornet anger vilken cykel som anvénds under
detta traningspass.
=0 Knapplas pa
Anger att knappldset ar pa.
Rec-symbol
Visas i traningslage nér stoppuret har startat och registrering av
traningsdata ar pa. Symbolen blinkar nar det finns lite minne kvar.
oh Intervallikon

Anger att intervalltraning har valts.

B

Countd. Timer
(Nedrakningstimer) Nedrakningstimer for tid

LEHBP vYarvnummer
Varvnummer och varvtid
AE Varystracka

I

_
=
-,

Stracka for aktuellt varv

Gk

Stopwatch (Stoppur)
Total traningstid hittills

- Heart rate (Aktuell puls)
Aktuell puls
-g. Avg heart rate (Snittpuls)
Snittpuls hittills under traningen
od Calories (Kalorier)
Antalet férbrukade kalorier (kcal)
AE Distance (Stracka)
Tillryggalagd stréacka hittills
A E Trip
T Avstand mellan punkt A och B. Detta vérde &terstalls varje gang du
trycker pa OK.
=] Arrival time (Ankomsttid)
Berdknad ankomsttid.
B-R RR variation

Variationen mellan hjartslagen, d.v.s. variationen i tid mellan
efterfoljande hjartslag.
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Symbol Forklaring
=d Cykelekonomi
Cykelekonomi som kcal/km eller Cal/mile och Kcal/tim eller Cal/tim.
Numerisk jamforelse av traning eller av omstandigheter eller mellan olika
cyklister.
At Ascent (Stigning i antal meter)
Stigning i meter/fot
In Descent (Utfor i antal meter)
Nedstigna meter/fot
s Inclinometer (Lutningsméatare)
Upp-/nedstigning i procent och grader. Berdkning i numeriska varden hur
brant sluttning eller stigning du cyklar.
Ve N Altitude (Hojd i m.6.h.)

Aktuell hdjd i m.g.h.

Temperature (Temperatur)
Temperaturavlasning (°C).
Eftersom din kroppstemperatur paverkar den faktiska
temperaturavlasningen uppnas en precis temperatur pa basta sitt genom
att man tar av cykeldatorn i minst 10 minuter.

ta)
T
-]

Cadence* (Kadens)
Méater trampfrekvensen (kadensen) pé pedalerna nar du trampar, méatt i
varv per minut.

=
=
[

Avg Cadence (Snittkadens)
Genomsnittlig kadens fran start.

@l 9

Speed (Hastighet)
Den aktuella hastighet som du cyklar med Informationen kommer fran
hastighetssensorn.

&

Max speed (Max. hastighet)
Maxhastigheten under din traning Informationen kommer fran
hastighetssensorn.

Avyg speed (Snitthastighet)
Genomsnittlig hastighet fran start. Informationen kommer fran
hastighetssensorn.

A Power * (Effekt)
Power Output sensor mater momentana, genomsnittliga och maximala
effektvarden.
O Pedal. index* (Pedalindex)

Beskriver hur jamn effektutvecklingen &r under ett pedalvarv.

L-R balance* (V/H balans)
Effektfordelning mellan vanster och hdger ben, i procent.

e »-.--u Zone pointer (for puls)
Om hjartat inte syns och ett alarm ljuder, ligger din puls utanfor
pulszonen.
Lelzl*lu]e] Zone pointer (for Polar sportzoner)

En hjartsymbol som flyttar sig mellan de olika zonerna indikerar vilken
sportzon pulsen befinner sig i. Mer information om hur du staller in en
sportzon finns i Knappfunktioner (sida 21).
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Forklaring

Traningszon
En graf som visar din puls i forhallande till den installda pulszonen.

Zone pointer (for hastighet)
Om symbolen inte syns och ett larm ljuder, ligger din hastighet utanfor
traningszonen.

Zone pointer * (fér kadens)
Om kadenssymbolen inte syns och/eller om du hér en signal &r du utanfor
gransvardena for kadenszonen.

Zone pointer * (effekt)
Om kadenssymbolen inte syns och/eller om du hor en signal ar du utanfor
gransvardena for effektzonen.

Tid inom zonen
Traningstid inom zonen

Speed* (Hastighet)
Aktuell hastighet. Informationen kommer frdn G5 GPS-sensor. Antalet
streck ovanfér bokstaven G anger signalstyrka for GPS.

Max speed” (Maxhastighet)
Max. hastighet hittills. Informationen kommer fran G5 GPS-sensor.

Average speed * (Snitthastighet)
Genomsnittlig hastighet hittills. Informationen kommer frdn G5
GPS-sensor.

* Tillbehorssensor kravs.

Knappfunktioner

Ta varvtider

Tryck pa OK for att lagra en varvtid. Displayen visar:

Varvnummer

Snittpuls under varvet

Varvtid

Varvnummer
Varvstracka
Snitthastighet

Lasa en sportzon
Nar du tranar utan forinstallda traningszoner (traningstyp FREE) kan du lasa den sportzon som din puls
befinner sig i for tillfallet. Mer information finns i Polar Sportzoner (sida 57). Pa sa satt kan du under
traningspasset bestamma traningszonen om du inte har bestamt traningszon i férvag.

Tryck och hall in LAP (OK) for att Lock ~Unlock zone (Lasa/6ppna zonen).
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Om du t.ex. tranar med en puls pa 130 slag/min (75 % av din maxpuls) vilket motsvarar Sportzon 3, kan
du trycka och halla in LAP for att lasa din puls i denna zon. Sport zone3 Locked 70-79 visas. Ett alarm
ljuder om din puls ligger utanfér zonen (om alarmet fér traningszonen &r aktiverat). Oppna sportzonen
genom att trycka och halla in OK igen: Sport zone3 Unlocked (Sportzon 3 6ppnad) visas.

Zooma displayen

o~
Heart rate

sl

A

Tryck och hall in UP for att zooma in den &vre raden eller DOWN for att zooma in mittenraden. Atergé till
normaldisplayen genom att trycka och halla knappen intryckt igen.

Belysa displayen (Nattlidge pa)
For att belysa displayen, tryck pad LIGHT under traningen. Nattlage aktiveras och displayen belyses
automatiskt nar nagon knapp trycks in, vid lagring av A.Lap eller vid byte av traningsfas.

Visa instillningsmenyn
Tryck och hall in LIGHT > Settings (Installningar)

Menyn Settings visas nar man trycker och haller in LIGHT. | installningsmenyn kan du &ndra vissa
installningar utan att avbryta traningsregistreringen. Menyinnehallet varierar med traningstyp. Mer
information finns i Installningar (sida 34).

¢ Prev. phase (Foregdende fas): Se summerad information fran den féregaende fasen eller upprepningen
(visas nar ett pass med faser skapats i Polar ProTrainer 5).

¢ Keylock (Knapplas): Las/las upp knapplaset for att forhindra oavsiktliga knapptryckningar.
* Autoscr. (Autobladdring): Valj pa/av som du vill att displayen skall vaxla automatiskt under traningen.
e TZ Alarm (TZ-alarm): Sla pa/av alarmet for traningszonen.

¢ Change zone (Byt zon): Byt tréningszon (visas nér du definierat flera zoner, men inte nar ett pass med
flera faser skapats med programmet Polar ProTrainer 5).

* HR view (Pulsformat): Valj hur du vill att din puls ska visas.

e Seek sensor (Sok sensor): Soker efter WearlLink, hastighets-, kadens-*, GPS-* och effektsensorn* om
signalen férsvinner under tréningen.

@ Din cykeldator héanvisar till pulssensorn som WearLink .

e A.Llap (Automatiska varvtider): Sla pa eller av funktionen fér automatisk lagring av varvtider.
e Arr. time (Ank.tid): Stall in ankomsttid pa av/pa.

Nar du har andrat instéllningarna fortsatter du i traningslage med cykeldatorn.

* Tillbehorssensor kravs.

Pausa traningen
Pausa traningsregistreringen genom att trycka pa STOP.

| pauslage kan du vélja:

e Continue (Fortsatt), for att fortsatta registreringen.

e Exit (Avbryt), for att avbryta traningen.

e Summary (Summering), for att fa en sammanfattning av traningsinformationen
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e Settings (Installningar), for att andra alla instéliningar som anvénts under traningspasset, inklusive
personliga installningar som du inte kan komma &t under traning.

o Reset (Aterstall), for att radera registrerad traningsinformation. Bekrafta med OK och tryck pa OK igen for
att ater starta traningsregistreringen.

e Reset trip (Aterstall tripmatare), for att nollstalla strackan. Bekrafta med OK och tryck pa OK igen for att
starta om traningsregistreringen.

e Location™ (Position), for att se aktuell position med GPS-koordinater. Latitud och longitud uttrycks i grader
och minuter. Antalet satelliter GPS-sensorn har kontakt med visas pa den nedre raden.

¢ Free mode (Fri traning), for att byta din traningsprofil till fri traningstyp. Detta raderar inte dina
registrerade data for den tréaning du gjort, utan traningen fortsatter utan instéliningar. Om du vaxlar till fri
traningstyp kan du starta om ursprungsprogrammet genom att pausa traningen igen och valja Restart P1
(Starta om P1 - Fasl).

*G5 GPS-sensor kravs som tillbehor.

Faststidlla din OwnZone

Mer bakgrundsinformation om Polar OwnZone® finns i OwnZone-traning (sida 58).
Vélj Settings > Exercise > DwnZone (Instéllningar > Traning >OwnZone).

Hitta dina gransvarden fér OwnZone inom 1-5 minuter under en uppvarmningsperiod genom att cykla, ga
eller springa. Du bor borja ditt traningspass forsiktigt med 13g intensitet och gradvis 6ka intensiteten for
att successivt hoja pulsen.

Omdefiniera din OwnZone:

e Nar du andrar traningsmiljo eller tréaningstyp.

e Nar du borjar trana efter mer an en veckas uppehall.

e Om du inte ar 100 procent saker pa din fysiska eller mentala status - t.ex. om du inte aterhdmtat dig fran
tidigare tréning, inte kanner dig kry eller &r stressad.

e Efter att ha andrat anvandarinstaliningarna.

Innan du borjar faststalla din OwnZone, kontrollera att:
¢ Dina anvandarinstéllningar ar riktiga.

Funktionen OwnZone ar aktiverad. Cykeldatorn kommer automatiskt att faststalla OwnZone varje gang du
borjar tréana, forutsatt att OwnZone-funktionen ar aktiverad.

1. Tag pa dig pulssensorn enligt anvisningarna. Starta matningen genom att trycka pa OK tva ganger.
2. Nér traningen pabérjas visas 0F och din OwnZone boérjar faststallas.

Faststallning av OwnZone sker i fem steg. Om ljudinstaliningen ar aktiverad hors en signal i slutet av varje
steg.

0Z > Cykla i lugn takt under 1 min. Hall pulsen under 100 slag/minut / 50 % aVaypuis Under den férsta
fasen.

0Z >> Cykla i normal takt under 1 min. Oka sakta pulsen 10 slag/minut /5 % aVmaxpuls-
0Z >>> Cykla i snabb takt under 1 min. Oka pulsen 10 slag/minut/ 5 % aVmaxpuls-

0Z >>>> Cykla i snabb takt under 1 min. Oka din puls 10 slag/minut/ 5 % aVmaxpuls-

0Z >33 >Cykla i snabb takt under 1 min. Oka pulsen ca 10 slag/minut / 5 % av maxpuls:

3. Nér du hor tva pipsignaler efter varandra betyder det att din OwnZone har identifierats.

4. DwnZone Updated (OwnZone uppdaterad) och pulszoner visas. Zonen visas i slag/min eller som procent av
maxpulsen (HR%) eller som procent av pulsreserven (HRR%), beroende pa dina installningar.

5. Om det inte gick att faststalla din OwnZone anvands din tidigare faststallda OwnZone och DwnZone Limits
visas. Om inget OwnZone tidigare definierats anvands automatiskt aldersbaserade varden fér pulszonen.

Nu kan du fortsatta traningen. Forsok att halla dig inom den angivna pulszonen for att for att fa ut
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maximalt av tréaningen.

Du kan hoppa &ver faststallandet av OwnZone och anvédnda en tidigare faststalld OwnZone genom att
trycka OK nar som helst under processen.

Den tid som tagits i ansprak for att faststalla din egen OwnZone inkluderas i din registrerade traningstid.

Avbryta traning

Pausa traningsregistreringen genom att trycka pa STOP. For att helt avbryta registreringen valjer du pa EXIT.
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6. EFTER TRANING

Ta hand om din pulssensor efter traningen.Lossa sdndaren fran béltet efter anviandning. Hall pulssensorn
torr och ren.

Fullstandiga instruktioner om vard och skotsel finns i Skétsel och underhall (sida 61).

Analysera traningsresultat

For att se grundlaggande traningsdata, titta i File-funktionen pa din cykeldator. Fér en djupare analys,
overfor datan till Polar ProTrainer 5. Programmet ger mdjlighet att djupare analysera
traningsinformationen.

Cykeldatorn och programvaran kommunicerar via IrDA. Oppna férst programmet. Valj sedan Connect
(Anslut) fran din cykeldator och placera den framfér det infrardda fonstret pa Polar IrDA USB 2,0 Adapter
(tillbehor) eller pa datorn eller ndgon annan IrDA-kompatibel ir-adapter. For fullstandiga instruktioner om
hur du for éver data, se Hjalp-funktionen i programvaran.

1. Oppna programmet Polar ProTrainer 5.
2. Valj Connect-lage i cykeldatorn och placera den framfér IR-fénstret.

3. Klicka pa Synkronisera (eller Anslut en pulsmatare) pa programverktygsfaltet i ProTrainer 5.
Mer information om hur du éverfér data finns i programmets Hjalp-fil.
Att granska tréningsfilen i cykeldatorn

Valj Fite (Fil) > OK for féljande alternativ:

e | Exercise Log (Traningslogg) sparas upp till 99 traningsfiler.

e Weekly (Veckosummering) innehaller traningssummering for de senaste 16 veckorna.
e Totals (Totalsummering) summering av dina totala traningsdata.

e | menyn Delete (Radera) kan du radera traningsfiler.

Traningslogg
Ga till File » Exercise log

File
» Exercice los

Weekly -

| Exercise log (Traningslogg) kan du se detaljerad information fran dina traningspass. Foljande
information visas:

e Tréningstyp
e Varje stapel representerar ett traningspass. Stapelns héjd motsvarar traningstiden.
e Datum for traningspass
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Information pa displayen (a - e visas nedan) beror pa installningar och traningstyp (t.ex. om din traning
inte bestar av faser sa visas ingen fasinformation).

Bladdra mellan staplarna med UP eller DOWN och tryck OK for att valja det traningspass du vill granska:

— . .

Basic a. Basic (Grundldggande information)
14:0002 T

IHZ kM -

L Ui

——
Bike n
information i
Bike 1 +
n

U

. 00018

e
Srort zone? c. Sport zones (Sportzoner)

b. Bike (Cykelinformation)

~alli.

] Ld J

——
Ridel T
Time Il

in Fhazes =+
N 130 4
U LU w
-

T2 ov W

d. Phases (Fasinformation)

N
3 laps 4 e. Laps (Varvtidsinformation)
Avs 00-20-1?1
Best1 +

] Ld J

a. Grundlaggande information

Valj File (Fil)> Exercise log (Tréningslogg). Bladdra UP och DOWN for att valja traningspass och tryck OK.
Bladdra UP och DOWN for att se féljande information:

Traningstyp

Tid nar traningen startade
Tillryggalagd stracka
Total traningstid

Heart rate (pulsislag/min, omvaxlande med puls i procent av maxpuls (HR%),
Max 160 eller i procent av din pulsreserv (HRR%)).
Min 188 Maxpuls under traningen
: '-I I Minpuls under traningen
Snittpuls under traningen

Heart rate T
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oy

HR zone 1 + Target zones (Traningszoner; puls/hastighet/kadens*/effekt*) omvaxlande zon 1,
Hish 152? zon 2 och zon 3.
Low 134+ Ovre gréns for zonen

Nedre gréns for zonen

- @ J

oy

Time i zonel+ Time in, above, and below [Tid inom, dver och under zon 1, 2 och 3)
Above 12-0'1* Tid dver zonen
Bﬂ""‘| E|3"':"*v Tid under zonen
+ - Tid inom zonen
F 1y
= @
N
Calories + Calories (Antalet kalorier som forbrukats under traningspasset).
1143 keal |l Energiforbrukningen (antal kcal) 4r ett bra matt pa totalanstrdngningen under

- traningspasset.

Tryck BACK (Tillbaka) for att aterga till visning av grundlaggande information.
Ytterligare grundldggande information

For att lagga in egen traningsinformation eller for att radera traningen fran File (Fil), tryck och hall in
LIGHT i visningen av grundlaggande information.

Valj File > DK > Exercise log > OK > Basic > OK (Fil > OK > Tréningslogg > OK > Grundlaggande > OK),
tryck och héll in LIGHT> Add info >0K (L&gg till info > OK).

e Rank (Rankning ): Gradera din traning.

e Feeling (Kansla): Utvardera din kansla under passet (0-5).

e Temperat. (Temperatur): Stall in temperaturen med UP eller DOWN.
¢ Distance (Stracka): Stall in stackan for Cykel 1, Cykel 2 eller Ovrig.

@ Om du &andrar strackan paverkar detta dven den totala strackan

b. Cykelinformation

Valj File > Exercise log > Bike information (Fil > Tréningslogg > Cykelinformation).

Bike n
information i
Bike 1 +

n
U

L Oeg

Tryck OK och bladdra UP och DOWN for att se cykelinformation:

N

Seeed knfh Speed [hastighet]
Max 532 Maxhastighet
e Snitthastighet
" EIE.E Distance (stracka)
\— )
N

Caderce Cadence [kadens]
Max msi Maximal kadens
Aus 86+ Genomsnittlig kadens
L2
\— )
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—
L/R balance?
Hags s 5er
Pedal. indexs

- @ J

oy
-

Ealorieﬁfkn{
kcaldfkm -

% |

&

Incline
Max a1
Max T

——

|

Decline
Max T
Max B%w

——

o
a—

o~

Altitude
Max IHBn!
Min E2me

HHFIUI;
a—

-

Temrerature
Max 24 "El
Min 21 “C+

_
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Power (effekt)

Maxeffekt

Genomsnittlig effekt

Cykeleffektivitet

Cykeleffektiveten ar din energiforbrukning som omvandlas
till effekt som forflyttar cykeln framat. Cykeleffektiveten
méts nér pulsen stiger dver 100 slag/min och traningen har
varat ldngre an en minut. Om pulsen sjunker under 100
slag/min under trdning upphér berdkningen av
cykeleffektivitet tills din puls stiger dver 100 slag/min igen.
Forbattringar i cykeleffektiviteten indikerar forbattrad
prestanda.

L-R balance [Vanster.hioger balans)
Vanster/hdger balans i %. Effektfordelning mellan véanster
och héger ben.

Pedalindex i %. Visar effektiviteten i rundtrampet.

Calories-km [genomsnittlig kalorifarbrukning
per kilometer)

Incline [uppFirslut)
Max lutning uppfor i %
Max lutning uppfér i grader

Decline [utfarslut)
Max lutning utfor i %
Max lutning utfor i grader

Altitude (hidjd]
Maxhojd

Minhsjd
Snitthdjd

AscentDescent (upp--nedstigning)
Stigning i meter/fot
Nedstigna meter/fot

Temperatur
Maxtemp. i °C
Mintemp. i °C
Genomsnittlig temp. °C
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Odometer + Odometer [totalstricka)
Bike 1 l Cykel 1, 2 eller 3
3195km + Kilometer

c. Sportzoner

Valj File > Exercise log > Basic > 0K (Fil > traningslogg > Grundlaggande > OK)

Srort ZOHEi{
-+

Tryck OK och bladdral UP eller DOWN for att se hur lange du trénat i varje sportzon. Har visas variationen
under traningspasset i diagramform.

Tryck BACK (Tillbaka) for att aterga till visning av information om Sport zoner.
d. Traningsfaser
Ga till File > Exercise log > Phases (Fil > Traningslogg > Faser)

Menyn Phases (Faser) visas endast om traningen skapas med programmet Polar ProTrainer 5 och
inkluderar faser.

Ride 1
Time

in Fhazes «
nl
ur

- O

Nar Sport zoner visas, tryck pa DOWN for att se information om Phases (Faser). Varje fas kan visas
separat.

Ga igenom datan for en fas genom att trycka pa OK. Bladdra mellan faserna genom att trycka pa UP eller
DOWN.

P11 Fasnamn
Time II Mellantid
00:15:00.0 Langd pé aktuell fas
AN. IC 80P
LU
\—= o+ o )
N
P11 Heart rate (pulsislag/min, omvaxlande med puls i procent av maxpuls (HR%),
Heart rate II eller i procent av din pulsreserv (HRR%)).
Max 159

I UL Maxpuls under fasen
I "I"I Snittpuls under fasen
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Increas. HR Skillnaden mellan pulsen i borjan och slutet av fasen. Aktuell puls i slag/min,

| omvéxlande med puls i procent av maxpuls (HR%), eller i procent av din pulsreserv
L (HRR%).

— Iw - Pulsokning: Om pulsen var lagre i borjan av fasen &n i slutet av fasen, kommer
cykeldatorn att visa skillnaden i puls (puls i slutet minus puls i borjan). Under en
arbetsfas kommer cykeldatorn att visa din pulsokning.

Puls6kning: Om pulsen var lagre i borjan av fasen an i slutet av fasen, kommer
cykeldatorn att visa skillnaden i puls (puls i slutet minus puls i bérjan). Under en
arbetsfas kommer cykeldatorn att visa din pulsokning.

Pulsdiff: Om pulsen var densamma i bérjan och slutet av fasen kommer cykeldatorn
att visa en pulsdiff pa 0.

P11 ﬂ Pulsokning .~ Pulsminskning ~ Pulsdiff.

HR differ. 25

Ty
P11 Speed [hastighet]
Sreed km/h II Maxhastighet under fasen
Max :ﬁ;;f Snitthastighet under fasen
o U.u
=3 o= [,
Ty
P11 Distance [strdckal
Dictance II Delstracka
ek Stracka for aktuell fas
" 15
=3 o= [,
Ty

Cadence Maximal kadens under fasen
Max 102 Genomsnittlig kadens under fasen

. W

L+ o [

P11 ﬂ Cadence* (kadens)

N
P11 Power [effekt]
Power " Maxeffekt under fasen
Max ;115 Genomsnittlig effekt under fasen
n
o U
] o= [,

Tryck BACK (Tillbaka) for att aterga till Phases (Faser).

* Extra sensor kravs.

e. Varvtidsinfo

Valj File > Exercise log > Basic > 0K (Fil > Tréningslogg > Grundlaggande > OK)

| visningen av Faser visas information om varvtider om du trycker DOWN. Information om varv visas bara
om mer an en varvtid lagrats i minnet.

Tlaps 4 Laps (Information om antal registrerade/automatiska varvtider)
Alus oo-eo-ﬂl

Genomsnittlig varvtid/automatisk varvtid
Best1 = Numret pé det bésta (snabbaste) varvet visas omvéxlande med dess tid.

Den sista varvtiden visas aldrig som béasta varv, aven om det &r det snabbaste varvet. Om du deltar i en
cykeltavling och vill att ditt sista varv ska inkluderas trycker du pa OK pa mallinjen istallet féor STOP.
Avsluta sedan registreringen efter malgang genom att trycka pa STOP.
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Bladdra genom varvinformation genom att trycka pa OK.

Jamfor motsvarande information for olika varv genom att trycka pa UP eller DOWN.

SVENSKA

For att se varvinformation |att 6verfér du traningsfilen till Polar ProTrainer 5 och analyserar traningen i vyn

Kurva.

Lar 2
Sreed kmsh
Aus 30:00

. by

] O J

——
Lar 2

Diztance

10.6 km

Lar 2
Cadence

Max 104

. Huﬁl.llv

] O J
N
Lar 2
FPower

Auvs 162 W

l 1
. i
oW

= o )

——
Lar 2

Pedal. inde:x

Aus 187

@

Time [varvy-~mellantider)
Mellantid
Varvtid

Heart rate (pulsislag/min, omvéxlande med puls i procent av maxpuls (HR%)
eller i procent av din pulsreserv (HRR%)).

Maxpuls under varvet

Snittpuls under varvet

Puls vid varvets slut

Speed [hastighet) km~h

Snitthastighet under varvet

Hastighet vid varvets slut

Tryck och hall in LIGHT for att andra hastighetsvisning.

Distance [strackal
Varvstracka

Ccadence* (kadens)
Maximal kadens under varvet
Snittkadens under varvet

Power (effekt)*
Snitteffekt under varvet
Effekt vid varvets slut

Pedalindex (rundtrampsindex)
Genomsnittligt %

Cykeleffektivitet

Cykeleffektiveten dr din energiforbrukning som omvandlas till effekt som forflyttar

cykeln framat. Cykeleffektiveten mats nar pulsen stiger Gver 100 slag/min och

traningen har varat langre 4n en minut. Om pulsen sjunker under 100 slag/min under
traning upphdr berakningen av cykeleffektivitet tills din puls stiger dver 100 slag/min

igen. Forbattringar i cykeleffektivitet anger forbattrad prestanda.

Efter traning
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S
Lae 2 T Incline [lutning)
Incline H Lutning i %

1s e Lutning i grader
b |

A
Lar 2 Altitude (hiijd)
Altitude II Asc (stigning i antal meter)
Rsc. 9°m” Hojd i m.6.h.

% |
] L=l J

e ——
Lap 2 I Altitude (hijd)
Altitude ll Desc (utfor i antal meter)
Desc.  10m

Hojd i m..h.

. g

] L=l J

S
Lar 2 ﬂ Temperatur

Temrerature

Lo

] Ld J

Tryck BACK for att aterga till visning av varv.

*Tillbeh6rssensor kravs.

Veckosummering
Ga till File > Weekly (Fil > Veckosummering)

| Weekly ser du en veckosummering av dina trdningsdata fér de 16 senaste veckorna. Stapeln langst till
hoger, kallad This week (Denna vecka) visar en summering av traningen denna vecka. De féregaende
veckostaplarna ar daterade pa séndagen i veckan. Bladdra mellan veckorna med UP eller DOWN och se

den totala traningstiden pa den nedre raden.
——
Sun 07.01.07

il
08395

Valj vecka med OK for att se veckans totala kaloriférbrukning, stracka och tréaningstid.
——
Thic week
Y360 keal

2534 km «

08395

Tryck pa DOWN for att se pulsens férdelning mellan Sportzonerna for veckans traningar.

-

ﬁ

Srort zones

For att se hur lange du tranat inom varje Sportzon, tryck pa OK och bladdra mellan zonerna med UP eller
DOWN.
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Totalvarden
Ga till File » Totals (Fil > Totalvarden)

Totals (Totalvarden) innehaller ackumulerade data som registrerats under alla traningspass sedan senaste
nollstalining. Anvand totalsummeringen som ett rdkneverk for traningsdata I6pande 6ver en manad, en
sasong eller ett ar. Vardena uppdateras automatiskt nar en traningsregistrering avslutas.

Anvand UP eller DOWN for att bladdra igenom féljande information:
e Bike 1 distance (Cykel 1 stracka) (Totalstracka for cykel 1; kan nollstallas)
e Bike 2 distance (Cykel 2 stracka)

e Bike 3 distance (Cykel 2 stracka)

¢ 6PS distance (GPS-stracka)

¢ Total distance (Totalstracka; kan nollstallas)

e Total duration (Total traningstid)

e Total calories (Total kaloriférbrukning)

e Total exerc. count (Totalt antal traningspass)

e Total ascent [Totalt antal stigningsmeter)

e Total odometer (total distansmatning; kan inte nollstallas)

e Reset totals (Nollstall totalvarden)

For att nollstalla totalvarden
Ga till File » Totals > Reset totals (Fil > Totalvarden > Nollstall totalvarden)

Valj vardet du vill nollstéalla i menyn och bekrafta med OK. Valj Yes (Ja) for att bekrafta nollstéaliningen.
Obs! Raderad information kan inte aterstéllas. Valj No (Nej) for att aterga till menyn Reset (Aterstall).

Radera filer
Valj File > Delete > Exercise (Fil > Radera > Tréning).

| Delete kan du radera ett traningspass i taget, alla pa en gang, eller nollstalla totalvarden.

Bladdra igenom féljande information med UP eller DOWN:

e Exercise (Trdningspass): Valj ett tréningspass som ska raderas.

e AW exerc. (Alla pass): Radera alla traningspass

e Totals (Totalvarden): Nollstall totalvardena ett i taget eller alla pa en gang.

Bekrafta med Yes (Ja).
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7. INSTALLNINGAR

Du kan enkelt andra installningarna via programvaran Polar ProTrainer 5. Mer information finns i
programmets Hjalp-funktion.

Traningsinstallningar
Ga till Settings > Exercise (Installningar > Traning)
F6ér mer information om traning, seTraningstyper (sida 34).

Funktionsinstallningar

Véalj Settings > Features (Installningar > Funktioner)

Settinss
Exercize

b Features

GPS*
Aktivera GPS-funktionen genom att valja Settings > Features > 6PS > On (Installningar > Funktioner >
GPS) Teach new sensor? (Instdllningar > Funktioner > 6PS > Pa. Ligga till ny sensor?] visas.

e Om din sensor redan har kodats in, valj No (Nej).

e (Om din sensor inte har kodats in @n, se Anvanda ett nytt tillbehér (sida 55) fér mer information om hur du
kodar en ny sensor.

*Tillbehorssensor kravs.

Héjdmatning

Cykeldatorn méter och visar hdjd (m.6.h.). Andra hdjdmétarens installningar i menyn RAltitude (hdjd).
Hoéjdmataren kan kalibreras manuellt eller automatiskt.

Manuell hdjdkalibrering

Valj Settings > Features > Altitude > Calibrate > set the altitude of current location (Installningar >
Funktioner > H6jd > Kalibrera > Stall in aktuell h6jd fran den plats du befinner dig pa)

Om platsen ligger pa en héjd som skiljer sig mycket fran den hojd som héjdmataren visar, kommer
Calibrate to xx? (Kalibrera till xx?) att visas.

Yes (Ja): Altitude calibrated to xx (HOjden kalibrerad till xx) visas.
No (Nej): Altitude calibration canceled (Hojdkalibrering avbruten) visas.

Kalibrera hojden for att vara saker pa att den ar korrekt. Stall in referenshdjden sa fort du har tillgang till
en tillforlitlig referenspunkt, som en bergstopp eller topografisk karta, eller havsytan.

Automatisk hojdkalibrering

Ga till Settings > Features > Altitude > AutoCalib > On-OFF (Instdllningar > Funktioner > Hojd >
Autokalibr. > Pa/Av)

Genom att anvanda automatisk hojdkalibrering kan du justera sa att utgangshéjden alltid ar samma néar du
startar traningen. Kalibrera héjden manuellt, och aktivera automatisk hojdkalibrering (AutoCalib).
Hadanefter kommer denna héjd att anvandas som utgangshéjd i borjan av traningen, nar automatisk
kalibrering anvands. Dessutom kommer det nya vardet att anvédndas som ny utgangshoéjd nar automatisk
kalibrering ar aktivt och du kalibrerar cykeldatorn manuellt.

Om hojden eller lufttrycket &ndras markant ombeds du att bekrafta &ndringen. Om du andrar hdjden visar
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Altitude calibrated to xx m-Ft (Hojden kalibrerad till xx m/ft) att kalibreringen har lyckats. Om Altitude
calibration Failed (Hojdkalibrering avbruten) visas maste du kalibrera om héjden.

Du kan ocksa stalla in hojden for automatisk kalibrering genom att anvanda mjukvaran Polar ProTrainer 5.
Mer information finns i programmets Hjalp-funktion.

@ Valj detta alternativ om du alltid startar tréningen pa samma plats (samma hdjd). Pa sa satt ar hdjdvardena
alltid korrekta.
Om sportprofilen for traningen innefattar automatisk kalibrering, bérjar alltid hdjdmatningen med denna hdjd
oavsett vilka allméanna hdjdinstéliningar som gjorts.

Lagringsfrekvens

Cykeldatorn registrerar traningsdatan med ett intervall pa 5 sekunder som standard. Du kan valja
lagringsfrekvens i Settings > Features > Rec.rate > 1 ~ 2 5 ~ 15 ~ &0 sec (Instadllningar > Funktioner >
Lagr.frekvens >1/2/5/ 15/ 60 sek.)

Cykeldatorn kan lagra puls, hastighet, kadens, effekt och h6jd med ett lagringsintervall pa 1, 2, 5, 15
eller 60 sekunder. Med ett langre (glesare) lagringsintervall kan du registrera traningsdata under langre tid
medan ett kortare (tatare) ger mer detaljerad information om puls och annan data. Det gér att man med
mjukvaran Polar ProTrainer 5 far en noggrannare dataanalys.

Ett kortare lagringsintervall gér att minnet fylls fortare. Aterstaende minnestid visas pa den nedre raden
nar du valjer lagringsfrekvens. Standardinstallningen ar 5 sekunder.

Nar mindre an 30 minuter av minneskapaciteten aterstar, andras lagringsfrekvensen och 6évergar
automatiskt till ett glesare intervall (1s > 2s > bs > 15s > 60s). Det maximerar den tid som det ar mojligt
att registrera data i minnet. Néar traningspasset avslutas, sparas den aktuella lagringsfrekvensen fér nasta
traningspass.

| féljande tabell visas den maximala lagringstiden for varje lagringsfrekvens. Den maximala lagringstiden
kan vara kortare om du lagrar ett stort antal korta filer.

@ Lagringsfrekvensen kommer att dndras automatiskt nar mindre an 30 minuter aterstar av lagringstiden. hemory

Low (Lite minne kvar) visas ndr 60 minuters minne aterstar,

R-R data Hastighet Kadens Effekt GPS Lagringsfrekvens
1s 2s 5s 15s 60s

Off (Av) Off (Av) 0ff (Av) Off (Av)  Off (Av) 3§ﬁ1hm Ogﬁ:‘in 41015:‘“ 1303n§ihn é:;?nZl:

0ff (Av) Off ) O OnPa)  off(a) o DRI R o an e SSh
Off (Av) Off ) OnPE  Off () Off(ay) oo SR B B3t gL
Off (Av) B
Off (Av) neH o) Offaw  offaw b R oh o S S
Off (Av) ey o) Ot onea NS B B B
Off (Av) 6h 13h  33h 92 368n

On (P&) Off (Av) On(Pa)  OFfF(AV)  yorin  30min 40min  10min  50min
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R-R data Hastighet Kadens Effekt GPS Lagringsfrekvens
1s 2s 5s 15s 60s

3h 7h 18h 53h 213h
40min 30min 40min 20min 30min

0ff (Av) On (P4) 0ff (Av) On (P4) On (P8)

0ff (Av) onPH  OnEH O Oonpa on MO0 B o bh o Ehdh
o T L T N S R A A i
o T L T R (R S Mt
On (Pa) Off ) Off (W Off () Off () o BN S ST
On (pa) off ) Offw  ona)  offa) S U B o S S
On (Pa) Off ) OnE O () Off () i N B o Seh
On (Pa) off ) Oona  ona)  offay S o0 aa o SIh o S
On (Pa) onPE O Off(w  offay 00 10RO Boh T Ao o seh
On (Pa) onEy O Offw  onem S oh o BRSO
On (Pa) nEE O 0neH  Off o 0n i B S
o L NP UM A
o e L R KON MU Sk
o e L e N MR UM S
On (P3) 3 6h 12h 23h  34h

On (Pd) On (P) On(Pd) — On(Pa)  ogrin 20min 50min OOmin  0Omin

@ Tiderna i tabellen ar ungefarliga. For R-R data, paverkas lagringstiden av din hjértfrekvens och
hjartfrekvensvariation. Om du lagrar varvtider och/eller skapar ett pass med faser i programvaran Polar ProTrainer
5 kommer den maximala lagringstiden att minska.

R-R datafunktion

Ga till Settings > Features > RR data > On-OfFf (Installningar > Funktioner > RR-data > P&/Av)

Med R-R-registrering méats och registreras intervallen mellan hjartslagen med en millisekunds
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noggrannhet. Det gbr att man kan analysera hjartfrekvensvariationen (HRV) med programvaran Polar
ProTrainer 5. R-R datafunktionen ar minneskrévande foér cykeldatorn, och nar du startar funktionen visas
aterstaende lagringstid i displayens nedre rad.

Automatisk varvregistrering.
Stall in stracka fér automatisk varvtidsregistrering

Ga till Settings > Features > A.Lap > On > set the lap distance (Installningar > Funktioner > Automatiska
varvtider > P& > stall in strackans langd) och ange en stracka for varvtidsregistreringen.

Cykeldatorn kommer automatiskt att registrera varvtider. Valj OFF (Av) for att stanga av funktionen.

Pulsformat
Valj ett format for att se pulsen

Select Settings > Features > HR wiew > HR ~ HR% .~ HRR* (Instéllningar > Funktioner > Pulsformat > Puls
i slag/min > Procent av maxpuls > Procent av pulsreserv)

Sportzoner
Ange Polar sportzoner i cykeldatorn

Ga till Settings > Features > Sport zones > Sport zone low limit (Instaliningar > Funktioner > Sportzoner
> Sportzon nedre grans)

Stall in den nedre gransen for zon 1 genom att trycka pa UP eller DOWN. Tryck sedan pa OK. Stéll in den
nedre gransen for varje zon pa samma satt. Nar den nedre gransen stalls in, stalls den dvre gréansen for
foregaende zon in automatiskt.

Tryck och hall in LIGHT for att vaxla mellan olika zonvisningar: HR* (procent av maxpuls) eller BP#
(slag/minut) eller HRR* (procent av pulsreserv).

Du kan enkelt andra installningarna med programvaran Polar ProTrainer 5. Mer information finns i
programmets Hjalp-funktion.

@ Du kan lasa/lasa upp en sportzon genom att trycka och halla in LAP (varv)-knappen medan du cyklar.

Cykelinstallningar (Bike Set)

Valj Settings > Bike (Installningar > Cykel)

Du kan ange tre cykelinstaliningar for cykeldatorn. Ange installningarna foér cyklarna, och nar du bérjar
tréana, valj cykel 1, 2 eller 3. Cykel 1 ar férvald.

Settinss
Features
+ Bike

Valj Settings > Bike > Bike 1, Bike 2, Bike 3 (Installningar > Cykel > Cykel 1, Cykel 2, Cykel 3) eller Other
(Annat). Cykel 2 och Cykel 3 kan aktiveras eller avaktiveras. Valj Other (Ovrigt) for att avaktivera
hastighets-, kadens- och effektsensorer och for att endast méata puls, héjd, temperatur och data som ges
av GPS-sensorn.

Hjulstorlek
Valj Bike > Bike 1 > Wheel (Cykel > Cykel 1 > Hjul)

Installning av hjulstorleken ar nddvandig for att fa korrekt cykeldata. Mer information angdende matning
av hjulstorleken finns i Mata hjulstorleken (sida 8).

Hastighet: Pa/av
Som standard ar hastigheten OFF (Av) for cykel 1.
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For att aktivera hastighetssensorn i din cykeldator, vélj Settings > Bike > Bike 1 > Speed > On
(Installningar > Cykel > Cykel 1 > Hastighet > P3). Teach new sensor? (Lagga till ny sensor?) visas.

e Om inlarning redan har utforts pa din sensor, valj No (Nej).

e Om inlarning inte har utforts pa din sensor, se Anvanda ett nytt tillbehor (sida 55) fér mer information om
inlarning av ny sensor.

@ Hastighetsinstéallningar girs antingen manuellt eller med programvaran Polar ProTrainer 5.

Ankomsttid
Véalj Settings > Bike > Bike 1 > Arr. time (Installningar > Cykel > Cykel 1 > Ank.tid)

Nar du anger den stracka du tanker fardas berdknar cykeldatorn den uppskattade ankomsttiden baserat pa
cykelhastigheten. Installera Polar hastighetssensor pa cykeln for att mata hastighet och stracka. For mer
information om hur du monterar hastighetssensorn, se bruksanvisningen till Polar hastighetssensor.

Arr. time O e Valj genom att trycka pa OK
Ony OFf : . . 1 , s
rsZt dict. * Valj Dn-0FF (P&/Av) for att stélla in funktionen pa eller av.

e Valj Set dist. (Stall in stracka) for att stalla in den stracka du ska
fardas.

Autostart: Pa/av
Valj Settings > Bike > Bikel > Rutostart (Instédllningar > Cykel > Cykel 1 > Autostart)

Autostart-funktionen innebar att lagringen av traningsdata startas och stoppas automatiskt nar du
bérjar/slutar cykla. Autostart-funktionen kraver Polar CS hastighetssensor W.I.N.D.

Power* (effekt): Pa/av
Som tillval kan du installera en effektsensor pa din cykel.

Nar du ska aktivera effektsensorn i din cykeldator valjer du Settings > Bike > Bike 1 > Power > On
(Installningar > Cykel > Cykel 1 > Effekt > Pa). Teach new sensor? (Lagga till ny sensor?) visas.

e Om din sensor redan har kodats in, valjNo (Nej).

e Om din sensor inte har kodats in an, se Anvanda ett nytt tillbehér (sida 55) fér mer information om hur du
kodar in en ny sensor.

Effektinstéliningar: Du maste ange kedjans vikt (g), kedjans langd (mm) och spannets langd (mm) i
cykeldatorn for att kunna avlasa korrekt effektinformation.

Om du anvander systemet Polar LOOK Kéo Power, f6lj instruktionerna nedan:

Véalj Settings > Bike > Bikel, Bike 2 or Bike 3 > Power > Settings (Instaliningar > Cykel > Cykel 1, Cykel 2
eller Cykel 3 > Effekt > Instéllningar) och

> Set chain weight 304 g > 0K (Stall in kedjans vikt 304 g > OK)
> Set chain length 1473 mm > 0K (Stall in kedjans langd 1 473 mm > OK)

» Set span length 420 mm > OK (Stall in kedjans spannvidd 420 mm > OK)

@ Fér att systemet Polar LOOK Kéo Power ska fungera korrekt méste cykeldatorn anvénda standardinstéllningarna fér
effekt. Aven om du vet de korrekta instéllningarna for din cykel ska du inte anvanda dem.

Om du anvander Polar Power Output Sensor™ W.I.N.D., f6lj instruktionerna nedan:

Vélj Settings > Bike > Bikel, Bike 2 or Bike 3 > Power > Settings (Instéliningar > Cykel > Cykel 1, Cykel 2
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eller Cykel 3 > Effekt > Instéllningar) och
> Set chain weight in grams > 0K (Stall in kedjevikten i gram > OK)
> Set chain length in millimeters > 0K (Stall in kedjeldngden i millimeter > OK)

> Set span length in millimeters > OK (Stall in spannvidden i millimeter > OK)

Exempel pa kedjevikter och -ldngder (pa grund av matvariationerna kan Polar inte hallas ansvarigt for
deras giltighet):

Vikt Langd
Shimano Dura-Ace CN-7700 280 g 1473 mm
Super narrow HG
Shimano Dura-Ace CN-7701 280 ¢g 1473 mm
Ultegra CN-HG92, 105
HG72,105 HG73
Shimano Sora CN-HG50 3356 ¢g 1473 mm
Campagnolo Record 2000, 10 260 g 1473 mm
Speed Chain
Campagnolo 10 Speed Chains 274 g 1473 mm
Chorus, Centaur
Campagnolo Veloce, Mirage, och | 277 g 1473 mm
Xenon

For precisa avlasningar maste alla installningar vara sa exakta som mgjligt. Kedjelangden och -vikten ar
direkt proportionerliga med effektvardet. Om det &r 1% fel kommer dven effektvardet att vara 1% fel.

@ Du behdver inte pa nytt ange kedjelangd och -vikt om nagra lankar tas bort. Systemet anvénder kedjedensitet
(vikt/langd). Att ta bort ldnkar fran kedjan paverkar inte densiteten.

Mer information om effektinstallningar finns i bruksanvisningen till effektsensorn.

@ Anvénd programvaran Polar ProTrainer 5 for effektinstéliningar.

*Tillbehdrssensor kravs.

Cadence* (kadens): Pa/av
Som tillval kan du installera en Polar kadenssensor pa din cykel.

Nar du ska aktivera kadenssensorn i din cykeldator valjer du Settings > Bike > Bike 1 > Cadence > On
(Installningar > Cykel > Cykel 1 > Kadens > P3a). Teach new sensor? (Ligga till ny sensor?) visas.

e Om din sensor redan har kodats in, valj No (Nej).

e Om din sensor inte har kodats in @n, se Anvanda ett nytt tillbehor (sida 55) fér mer information om hur du
kodar in en ny sensor.

Anvandarinstallningar

Ange korrekt anvandarinformation i cykeldatorn for att fa noggrannare feedback pa din prestation.

For att stalla in anvandarinformationen i I6pardatorn, valj Settings > User (Installningar > Anvéandare)

Settinss
Bike

+Uzer

e Weight (vikt):For att byta enheter (kg <--> Ibs), tryck och hall in LIGHT.
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e Height (langd):For att byta enheter (cm <--> ft), tryck och hall in LIGHT.
¢ Birthday (fodelsedatum): dd=dag, mm=manad, yy=ar

e Sex (kon): Male/Female (man/kvinna)

e Activity (aktivitetsniva):Top (elit) /High (hég) /Moderate (medel) /Low (l1ag)
e Heart Rate (puls): HR, ., (maxpuls), HRgj

®  Vi2max: Maximal syreupptagningsférmaga

Aktivitetsniva

Aktivitetsnivan ar en vardering av din fysiska aktivitetsniva 6ver tid. Valj det alternativ som bast beskriver

frekvensen och intensiteten for din fysiska aktivitet under de senaste tre manaderna.

e Elit: Du agnar dig at nagon fysiskt kravande aktivitet minst fem ganger i veckan eller trénar for att forbattra
dig infor en tavling eller ett lopp.

e Hog: Du agnar dig at nagon fysiskt kravande aktivitet atminstone 3 ganger i veckan, t.ex. du cyklar 2-4
timmar (40-120 km / 25-75 miles) per vecka eller agnar lika lang tid at jamforbar fysisk aktivitet.

e Medel: Du motionerar regelbundet, dvs. du cyklar 1/2-2 timmar (15-40 km / 3-25 miles) per vecka, eller
agnar lika lang tid at jamforbar fysisk aktivitet, eller ditt arbete kraver en viss fysisk aktivitet.

e Lag: Du motionerar inte regelbundet eller dgnar dig at tunga fysiska traningar, dvs.du &gnar dig endast
sporadiskt at traning som gor att du svettas eller blir andfadd.

| cykeldatorn anvands dessa varden for att berakna din energiférbrukning.

Heart Rate (puls): HR,a, HRGit

HRmax (maxpuls): Din aldersbaserade maxpuls (220 - &lder) anvands som standard. Stall in din maxpuls
manuellt om den faststallts i ett laboratorium, om du har utfort konditionstest med Polar CS600X
cykeldator eller om du sjalv har matt upp din maxpuls.

HR;; (puls i sittande stéllning): Din aldersbaserade HR.;; anvands som standard. Stall in ditt HR;-véarde
om du faststallt det enligt instruktionerna. Instruktioner finns under Puls i sittande stallning (sida 59) i
Bakgrundsinformationen.

Maximal syreupptagningsformaga: V0,,,.,

VO,max ar den maximala mangd syre kroppen kan ta upp vid maximal anstrangning. Det bésta sattet att
mata VO, ar att gora ett konditionstest i ett laboratorium. Om du vet din exakta kliniskt testade VO, .4
kan du stalla in vardet i cykeldatorn. | annat fall kan du méata ett motsvarande varde, Ownlndex, genom att
utféra Polar Fitness Test™. Mer information finns i Polar Fitness Test™ (sida 47).

Om nagra andringar gors i anvandarinstéliningarna visas User settings uvpdated (Anvandarinstallningar
uppdaterade).

Du kan fora in och &ndra anvéndarinstaliningar med programvaran Polar ProTrainer 5. Mer information
finns i programmets Hjalp-funktion.

Allmanna installningar

Settinss
Uzer

» General

Ljud

Vélj Settings > General > Sound (Instaliningar > Allmant > Ljud)

Volym

Ga till Settings > General > Sound > Yolume > On .~ OFF (Installningar > Allmant > Ljud > Volym > Pa/Av)

Volyminstallningarna styr knappljuden och aktivitetsljuden under traning. Detta paverkar inte klockans
alarm eller alarm for tréningszonen (TZ Alarm).
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TZ Alarm (Alarm for trdningszon)
Du kan stalla in TZ Alarm P&/ Av:

Vélj Settings > General > Sound > TZ Alarm > On ~0FF (Installningar > Allméant > Ljud > TZ-larm > P&/Av)

Om alarmet for traningszonen ar avaktiverat, kommer pulsvardet att blinka nar du ar utanfor
tréningszonen.

Knapplas

Bestamma knapplasinstallningar

Ga till Settings > General > Keylock > Manual ~ Automatic (Installningar > Allmant > Knapplas >
Manuellt/Automatiskt)

Med knapplaset undviker du att oavsiktligt trycka pa nagon av knapparna.

Manual (manuellt): Aktivera manuellt knapplas.

Automatic (Automatiskt): Knapplaset aktiveras i klocklage nar inga knappar tryckts in pa en minut.

Om du vill sla Dn-0ff (Pa/Av) knapplaset trycker du och haller in LIGHT i minst en sekund och trycker OK.

Enheter
Stall in de enheter du féredrar i 16pardatorn

Ga till Settings > General > Units > Kg-cm-km or lbsFtrmi (Instdliningar > Allmant > Enheter >
kg/cm/km eller Ib/ft/m)

Sprak
Valja sprak

Valj Settings > General > Language > English ~ Deutsch ~ Espaiiol ~ Francais ~ Italano (Instéllningar >
Allmant > Sprak > Engelska / Tyska / Spanska / Franska / Italienska)

Viloldge

Aktivera vilolage

Valj Settings > General > Sleep > Activate sleep mode? > Yes (Installningar > Allméant > Vilolage >
Aktivera vilolage? Ja)

Att aktivera vilolaget sparar batteri nar cykeldatorn inte anvands under en langre tid. Klockans alarm
fungerar ocksa i vilolage.

For att vacka nytt liv i cykeldatorn
Tryck pa valfri knapp > Turn display on? > Yes ~ No (Aktivera display? > Ja/Nej)
Yes (Ja):: cykeldatorn aktiveras.

No (Nej): cykeldatorn atergar till vilolage.

Klockinstallningar

Settinss n
Gener al l

» Watch

Paminnelse
Stall in en paminnelse for att komma ihag olika datum och tréaningspass.
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Ga till Settings > Watch > Reminders > Add new (Installningar > Klocka > Paminnelser > Lagg till ny)
Date (datum) Ange datum for handelsen, dd=dag, mm=manad, yy=ar.

Reminder time (Paminnelsetid): Ange tid for handelsen.

Alarm (Larm): Stall in nar larmet ska ljuda: pa klockslaget, 10 min / 30 min / 1 timme fére handelsen.
Sound (ljud): Valj ljudtyp for alarmet: Tyst/pip/normal.

Repeat (upprepa): Valj om paminnelsen ska upprepas en gang/ varje timme/ varje dag/ en gang i veckan/
en gang i manaden /en gang om aret.

Exercise (pass): Valj ett traningspass som ska kopplas till paminnelsen. Nar paminnelsen aktiveras
presenterar cykeldatorn detta traningspass som standard. Valj NONE (ingen) om du inte vill koppla ett
traningspass till paminnelsen.

Rename (d6p om): For att namnge paminnelsen, valj bokstaver med UP eller DOWN och godkann med OK.
Du kan programmera in sju paminnelser i cykeldatorn.

Se aktiva paminnelser och andra dem

Ga till Settings > Watch : Reminders (Instaliningar > Klocka > Paminnelser)

Valj vilken paminnelse som ska granskas, redigeras, dépas om eller raderas.

Evenemang
Stalla in nedrakning till ett evenemang i cykeldatorn

Ga till Settings > Watch > Event (Instéallningar > Klocka > Handelse)

Event day (datum for evenemang): dd=dag, mm=manad.

Rename (dop om): For att namnge evenemanget, valj bokstédver med UP / DOWN och godkann med OK.
Andra nedrakningen till evenemanget

Ga till Settings > Watch > Event (Instéallningar > Klocka > Handelse)

Du kan granska nedrakningen, stélla in ett nytt datum, dépa om den eller radera den.

| klocklage doljer eller visar du nedrakningen genom att trycka och halla UP.

Alarm
Stall in ett alarm pa din cykeldator

Ga till Settings > Watch > Alarm > OFF ~ Once ~ Mon-Fri ~ Daily (Instaliningar > Klocka > Larm > Av / En
gang / Man-fre / Dagligen) (av / en gang / man-fre / dagligen)

Du kan stalla in alarmet sa att det aktiveras antingen en gang Once), om dagen mellan mandag och fredag
(Mon-Fri), dagligen (Daily) eller kan du stédnga av det OFf. Alarmet ljuder i alla funktionsldgen utom under
traning, och det ljuder i en minut om du inte trycker pa STOP. Klockans alarm fungerar ocksa i vilolage,
och aven om du har sténgt av ljudet i Beneral settings (Allmanna installningar).

For att snooza i tio minuter, tryck p& UP,DOWN eller OK: Snooze visas och snoozetimern bérjar rakna ned.
Tryck STOP fér att avbryta snooze-funktionen.

Om en batterisymbol visas pa displayen ar batteriet svagt och du kan inte aktivera alarmet.

Klocktid
Stall in tid 1 i cykeldatorn
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Installningar Settings > Watch > Time 1 > 24h ~ 12h (Installningar > Klocka > Tid 1 > 24h / 12h)
Stall in tid 2 i cykeldatorn

Installningar Settings > Watch > Time 2 > 24h ~ 12h (Installningar > Klocka > Tid 2 > 24h / 12h)
Stall in 6nskad skillnad mellan tid 1 och 2 i timmar med UP/ DOWN-knapparna.

Tidszon
Véxla mellan tidszoner

Ga till Settings > Watch > Time zone > Time 1 ~ Time 2 (Installningar > Klocka > Tidszon > Tid 1 / Tid 2)
Valj en tidszon

| klocklage byter du tidszon genom att trycka och halla DOWN. Siffran 2 i det nedre hogra hornet pa
displayen indikerar att Tidszon 2 anvands.

Datum
Installning av datum i cykeldatorn

Ga till Settings > Watch > Date (Installningar > Klocka > Datum)
dd=dag, mm=manad, yy=ar

Du kan enkelt andra installningarna med programvaran Polar ProTrainer 5. Mer information finns i
programmets Hjalp-funktion.

Snabbvalsmeny
Vissa installningar kan andras via en snabbvalsmeny ifran klocklaget.

Tryck och hall in LUGHT > ABuick menu (snabbvalsmeny)
¢ Keylock (knapplas)

e Reminders (paminnelser)

¢ Alarm (Larm)

e Timezone (tidszon)

e Sleep (vilolage)
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8. TRANINGSPROGRAM

Granska traningsprogram

Skapa och ladda ner personliga traningspass till din cykeldator med programvaran Polar ProTrainer 5.
Detta kapitel innehaller en grundbeskrivning av hur man anvander och hanterar traningsprogrammet nar
det har laddats ner till cykeldatorn, Fér mer information om hur du skapar traningsprogram med
programvaran, for dver dem till cykeldatorn och analyserar din prestation efter tréningen, se Hjalpen till
Polar ProTrainer 5.

Nar du laddat ner traningsprogrammet visas ytterligare tvad menyer i cykeldatorn, dar du kan se ditt
program eller kontrollera ditt schema. Bladdra mellan veckor, dagar och traningspass med UP eller DOWN.
Valj vecka och dag med OK.

E—
Today T
£i2a |
=3 O

Prosram T
-+

g @@

3  DW

Titta pa ditt veckoprogram
Ga till Program > Week view (Program > Veckosummering)

Veckovisningen ger en dverblick 6ver veckans traningspass. Den vita stapeln visar planerad traningstid och
den svarta den utférda traningstiden. Maltraningstiden per vecka visas nedanfor staplarna.

Tryck och hall in LIGHT for att visa foljande information om veckan:
e Week info (Veckoinfo) Veckans namn och beskrivning.

e Targets (Mal): En summering av veckans mal. Kalorier, stracka och varaktighet. Planerad tid for
sportzoner: tryck OK och bladdra mellan sportzonerna med UP eller DOWN.

¢ Results (Resultat): En summering av veckans resultat. Kalorier, strédcka och varaktighet. Planerad tid for
sportzoner: tryck OK och bladdra mellan sportzonerna med UP eller DOWN.

e Reminder (Paminnelse): Stall in alarmet (i tid, 10 min, 30 min eller 1 timme fére traning) och valj ljudtyp
(Tyst, Pip, Alarm).
¢ Program off (Program av): Ta bort programmet fran din cykeldator.

Titta pa ditt veckoprogram
Ga till Program > Week view > Day view
Ga till Today > Exercise view

Dagsvisningen ger en 6verblick éver alla dagliga traningspass. Den vita stapeln visar planerad traningstid
och den svarta den utférda traningstiden. Den planerade tréaningstiden per dag visas nedanfér staplarna.

Tryck och hall in LIGHT for att visa ytterligare information om dagens tréning:

e Targets (mal): En summering av dagens mal. Kalorier, stracka och varaktighet. Planerad tid for sportzoner:
tryck OK och bladdra mellan sportzonerna med UP eller DOWN.

e Results (resultat): En summering av dagens resultat. Kalorier, stracka och varaktighet. Planerad tid for
sportzoner: tryck OK och bladdra mellan sportzonerna med UP eller DOWN.

Titta pa dina dagliga traningspass
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Ga till Program > Week view > Day view > Exercise view (Program > Veckosummering > Dagens traning >
Traningspass)

Traningsvisningen visar foljande information: traningstyp, beskrivning och mal for traningstid.

Tryck och hall in LIGHT for att visa foljande information:

e Targets (mal): En summering av malen for passet. Kalorier, stracka och varaktighet. Planerad tid for
sportzoner: tryck OK och bladdra mellan sportzonerna med UP eller DOWN.

e Phases (Faser):En summering av passets faser.

¢ Sport profile (Sportprofil): Se namnet pa den valda sportprofilen. Fér mer information se
Hjalp-funktionen i programvaran Polar ProTrainer 5.

¢ Reminder (Paminnelse): Stall in tiden fér paminnelsen.

Trdna med programmerade traningspass

Borja trana

Om du staller in en paminnelse kommer din cykeldator att pAminna dig om att trana planenligt pa
schemalagd dag. Titta pa traningsdatan for den planerade traningen genom att trycka OK nar paminnelsen
aktiverats.

Starta dagligt tréningspass
Valj Today > Exercise view (Traningspassets namn) > OK

Vélj Program > Week view > Day view > Exercise view > OK > OK (Program > Veckosummering > Dagens
traning > Traningspass > OK > OK)

For mer information om tréningsregistrering, se Borja tréna (sida 16). Din cykeldator kommer att hjalpa
dig igenom passet.

Trdna med faser
Nedan finns ett exempel pa ett pass med intervalltraning, som delats in i fyra faser:

Uppvéarmning / P1: Cykla i 15 minuter med en puls pa 60-70 % av maxpuls.

Intervall / P2: Cykla 5 km med en puls pa 80-90 % av maxpuls.

Intervall / P3: Cykla i 5 min med en puls pa 55-65 % av maxpuls. Repetera fas tva och tre 3 ganger var.
Nedvarvning / P4: Cykla i 15 minuter med en puls pa 55-65 % av maxpuls.

Visning under passet
Under passet visas féljande information pa displayen:

Varje fas inleds med att displayen visar:
Fasnamn

Zontyp

Zongranser

Under tréningsfasen visar displayen:

Nedrakning av tid/stricka, tidsatgang, numret pa nuvarande fas
Traningszonen i diagramform (uppdateras var 10 sek. och visar de senaste 8
minuternas traning pa displayen)

Aktuell puls

Antal aterstaende fasupprepningar
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) Efter varje avslutad fas visas:
%][]lg[lo Fasens varaktighet eller stracka
| e Pulsdifferensen (hur mycket din puls dkat eller minskat under fasen) eller
'-IH snitthastighet.
[_ Lj Snittpuls under fasen
Den avslutade fasens nummer

-
o

0 Ridei Nar ett programtraningspass ar 6ver visar denna display att traningen ar slutférd,
comFleted. Ride 1 completed (Stracka 1 slutford) kommer att visas.
-» Free mode Cykeldatorn dvergar till laget for fri traningstyp, och du kan fortsatta traningen utan

instéliningar. Traningen registreras och arkiveras.

2 €

STOFP LA [}

Mer information om hur du planerar traningspassen och 6verfér dem till din cykeldator med programvaran
Polar ProTrainer 5 finns i Hjalp-funktionen.

Funktioner under traning
Andra samma installningar for programtréning som foér alla andra traningstyper. Mer information om olika
funktioner under traningen finns iKnappfunktioner (sida 21).

Programtraningen anvander samma sportprofilinstaliningar som stallts in i programvaran Polar ProTrainer
5. Om du andrar cykeldatorns instéllningar under tréning (t.ex. pulsformat), kommer &ndringarna endast
att galla nuvarande pass. Nasta gang du pabérjar samma pass kommer cykeldatorn att anvanda den
sportprofil som definierats i programvaran.

Meny
For att se varvmenyn under programtraning tryck och hall in 0K. Bladdra mellan alternativen med UP /
DOWN och valj med OK. Innehallet i menyn beror pa din traningstyp.

e End phase (avsluta fas): Avsluta nuvarande fas och ga till nasta fas i passet.
e Jump to (hoppa till): Hoppa till valfri fas i passet.

For att se traningsresultaten, Valj File > Exercise log (Fil > Traningslogg)

Nar ett programtraningspass ar avslutat sparas din traningsdata under File (Fil).Mer information finns i
Analysera traningsresultat (sida 25).
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9. TESTER

Polar Fitness Test™

Vélj Test > Fitness (Test > Kondition)

Tezt
b Fithess

Ortimizer =

Polar Fitness Test™ ar ett enkelt, sakert och snabbt satt att mata din aeroba (kardiovaskulara) kondition i
vila. Resultatet, Polar Ownlindex, ar jamférbart med den maximala syreupptagningsférmagan (VO5,,,), Som
vanligen anvands for att utvardera den kardiovaskulara konditionen. Din fysiska aktivitet under en langre
period, puls, pulsvariation i vila, kon, alder, l1angd och kroppsvikt paverkar ditt OwnlIndex. Polar Fitness
Test har utvecklats for att anvéndas av friska vuxna.

Den aeroba konditionen bestams av hur effektivt ditt kardiovaskulara system transporterar syre till
kroppen. Ju battre aerob kondition, desto starkare och effektivare ar ditt hjarta. God aerob kondition har
manga fordelar for halsan. Det hjalper t.ex. till med att sénka hogt blodtryck och risken for hjart-
karlsjukdomar och stroke. Om du vill forbattra din aeroba kondition, tar det i genomsnitt 6 veckor med
regelbunden traning innan du kan maérka skillnaden pa ditt Ownlndex. Mindre valtranade personer kan
marka skillnaden fortare. Ju béattre din aeroba kondition ar desto mindre blir férandringarna i ditt
Ownlndex.

Det basta sattet att férbattra den aeroba konditionen &r genom tréaning dar stora muskelgrupper anvands.
S&dan traning kan t ex vara promenader, 16pning, cykling, rodd, simning, skridskodkning och
langdskidakning.

Fo6lj din utveckling med hjalp av Ownlndex. Genomfér Polar Fitness Test ett par ganger under de forsta tva
veckorna for att fa ett startvarde, och upprepa sedan testet ungefar en gang i manaden.

Med Polar Fitness Test kan du ocksa berakna din maxpuls (HR ,.x-p). The HR,.-p-vérdet beraknar din
individuella maxpuls battre &n den aldersbaserade formeln (220 - alder). Mer information om paupuis, S€
Anvandarinstallningar (sida 39).

For att forsékra dig om att testresultaten &r palitliga ska foljande grundlaggande krav uppfyllas:
¢ Du kan utfora testen var som helst — hemma, pa jobbet eller pa ett gym — férutsatt att du har en lugn miljé

for testen. Det far inte forekomma stérande ljud (till exempel fran tv, radio eller telefoner). Se ocksa till att
ingen pratar med dig under testen.

e Du bor alltid utfora testet pa samma plats, vid samma klockslag och i samma miljo.

e Undvika att ata eller roka 2-3 timmar fore testen.

e Var lugn och avslappnad. Lagg dig ned och slappna av ett par minuter innan du pabdrjar testen.

For videohandledning, ga till http://www.polar.com/en/polar_community/videos.

Fore testet
Tag pa dig pulssensorn

Mer information om tillgangliga installningar finns i Tag pa dig pulssensorn (sida 14).
Skriv in Anvandarinstallningar
Valj Settings > User (Instaliningar > Anvandare)

For att kunna genomféra Polar Fitness Test maste du ange din personliga anvandarinformation (om du har
angett den tidigare beho6ver du inte gora det igen) och din normala fysiska aktivitetsniva i
Anvandarinstaliningar (sida 39).
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Aktivera HR,.x-P
Om du vill berdkna din maxpuls maste du aktivera HR p,5-P-
Véalj Test > Fitness > HR max -p > On (Test > Kondition > HR max -p > Pa)

Genomfora testet
Vélj Test > Fitness > Start > Fitness Test Lie Down (Test > Kondition > Starta > Konditionstest Ligg ner)

Konditionstestet startar efter fem sekunder. Pilar indikerar att testet pagar. Ligg avslappnad och undvik
kroppsrorelser och samtal.

Om du inte har angett nagon fysisk aktivitetsniva i User Settings visas Set your personal activity level
(Stall in din personliga aktivitetsniva). Valj Top (Elit), High (H6g), Moderate (Medel), eller Low (Lag). Mer
information om aktivitetsnivaer, se Anvandarinstallningar.

Om din cykeldator inte tar emot din puls nar du startar testet eller under pagaende test, misslyckas testet
och Test Failed, check Wearlink (Testet misslyckades, kontrollera WearLink) visas. Kontrollera att
elektroderna pa pulssensorn ar fuktade och att baltet sitter at ordentligt runt bréstkorgen och pabdrja
sedan testet igen.

Nar testet ar slutfort ljuder tva pipsignaler. Ownlndex visas med ett siffervarde och en utvarderingsniva.
Mer information om utvarderingar, se Konditionsnivaer.

For att visa din Predicted maximum heart rate (berdknad maxpuls), tryck p4 DOWN. Tryck p& OK for att ga
ur.

Update to Y02 max? (Uppdatera VO2-max?) visas.

e ValjYes (Ja) for att spara Ownlndex-vardet i dina anvandarinstaliningar och din Fitness Test Trend
(konditionsutveckling)-meny.

e Valj No (Nej) endast om har ditt laboratorieméatta VO,,,-vérde och om det skiljer sig mer &n en
konditionsniva fran Ownlndex-resultatet. Ditt OwnIndex-véarde sparas da i menyn Fitness Test Trend
(Konditionsutveckling). Fér mer information, se Konditionsutveckling.

Update to HR max? (Uppdatera maxpuls?) (Om HRmax-p(Om HRmax-p &r aktiverat) visas.
e ValjYes (Ja) for att spara vardet i dina anvandarinstaliningar.
e Valj No (Nej) bara om du har laboratoriematt din maxpuls.

Avbryt testet nar som helst genom att trycka pa STOP. Fitness Test canceled (konditionstestet avbrots)
visas under nagra sekunder.

Nar Ownlndex och HR,x-p-vérden har sparats kommer de att anvandas for att berékna kaloriférbrukning.

Efter testet
Konditionsnivaer

OwnlIndex-vardet ska i férsta hand anvéndas for att jamféra dina personliga resultat och visa de
forandringar som skett. Ownlndex kan ocksa tolkas baserat pa din alder och kon. Leta reda pa ditt
Ownlndex i tabellen nedan och ta reda pa hur din kondition kan jamféras med andra personer av samma
alder och kon.

Mycket véltranade personer som utévar konditionskravande idrotter har Ownlndex- varden som ligger dver
70 (fér man) och 60 (for kvinnor). De hogsta Ownlndex-vardena uppnas i sporter som involverar stora
muskelgrupper, t.ex. 16pning och langdskidakning.

Maén
Rider/Ar Mycket l3g  Lag Acceptabel Medelhdg  Bra Mycketbra  Elit
20-24 <32 32-37 38-43 44-50 51-56 57-62 > 62
25-29 <31 31-35 36-42 43-48 49-53 54-59 >59
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Rider/Ar Mycket l3g  Lag Acceptabel  Medelhdg  Bra Mycketbra  Elit

30-34 <29 29-34 35-40 41-45 46-51 52-56 > 56
35-39 <28 28-32 33-38 39-43 44-48 49-54 > 54
40-44 <26 26-31 32-35 36-41 42-46 47-51 > 51
45-49 <25 25-29 30-34 35-39 40-43 44-48 > 48
50-54 <24 24-27 28-32 33-36 37-41 42-46 > 46
55-59 <22 22-26 27-30 31-34 35-39 40-43 > 43
60-65 <?1 21-24 25-28 29-32 33-36 37-40 > 40

Kvinnor

Rider/Ar Mycket I3g  Lag Acceptabel  Medelhdg  Bra Mycketbra  Elit

20-24 <27 27-31 32-36 37-41 42-46 47-51 > 51
25-29 <26 26-30 31-35 36-40 41-44 45-49 > 49
30-34 <25 25-29 30-33 34-37 38-42 43-46 > 46
35-39 <24 24-27 28-31 32-35 36-40 41-44 > 44
40-44 <22 22-25 26-29 30-33 34-37 38-41 >41
45-49 <21 21-23 24-217 28-31 32-35 36-38 > 38
50-54 <19 19-22 23-25 26-29 30-32 33-36 > 36
55-59 <18 18-20 21-23 24-27 28-30 31-33 >33
60-65 <16 16-18 19-21 22-24 25-27 28-30 > 30

Indelningen &r baserad pa en litteraturgenomgang av 62 studier dér VO, mattes direkt pa friska, vuxna
individer i USA, Kanada och sju europeiska lander. Referens: Shvartz E, Reibold RC. Aerobic fitness
norms for males and females aged 6 to 75 years: a review. Aviat Space Environ Med; 61:3-11, 1990.

Konditionsutveckling
Valj Test > Fitness > Trend (Test > Kondition > Utveckling)

Se hur dina Ownlndex-véarden har utvecklats i menyn Trend (Utveckling). Upp till 16 OwnlIndex-varden
med respektive datum visas pa displayen. Nar minnet ar fullt raderas det aldsta testresultatet automatiskt.

Det senaste testdatumet, ett diagram med dina Ownlndex-varden och det senaste Ownlndex-vardet visas.
Bladdra UP eller DOWN for att se 6vriga resultat.

Radera Ownlindex-vdrde
Valj Test > Fitness > Trend (Test > Kondition > Utveckling)

Valj det varde du vill radera och tryck pa och hall in LIGHT > Delete value? No-Yes (Radera varde?
Nej/Ja) visas. Bekrafta med OK.

Analysera Ownlndex-resultaten med programvaran Polar ProTrainer 5

Genom att ladda ner testresultaten till programmet Polar ProTrainer 5 kan du analysera dem pa olika sétt,
samt fa tillgang till mer detaljerad information om din utveckling. Med programmet kan du ocksa gora
diagramjamforelser med tidigare resultat. Resultaten fran Polar Fitness Test laddas ner automatiskt till
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programvaran nar du laddar ner traningsdata med funktionen Synkronisera.

Polar OwnOptimizer™

Fithess
b OFrtimizer +

Test H

I allmanhet

for att traningen ska ge resultat kravs det att man tillfalligt dverbelastar kroppen genom: langre tréning,
med hogre intensitet eller hogre total traningsvolym. For att undvika att allvarligt 6verbelasta kroppen,
kravs det att dverbelastningen foljs av tillracklig vila. Om du inte vilar tillrackligt kan din prestation
forsamras, istallet for forbattras, p.g.a. allt fér mycket traning, s.k. 6vertréaning. Polar OwnOptimizer &r ett
enkelt och tillforlitligt satt att avgdra om din trédning utvecklar din prestation optimalt. Polar OwnOptimizer
har utvecklats for friska vuxna.

Polar OwnOptimizer ar en modifiering av ett traditionellt ortostatiskt 6vertraningstest. Det ar ett perfekt
verktyg for konditionsfoérbattring eller for att na tavlingsmal, inbyggt i cykeldatorn, och som kan anvandas
av alla som tranar regelbundet minst tre ganger i veckan. Funktionen baseras pd matning av puls och
pulsvariation som gors under ett ortostatiskt test (staende efter avslappnad vila). Med OwnOptimizer
optimerar du din traningsbelastning under ett traningsprogram sa att du férbattrar din prestation och inte
under- eller 6vertranar over tid. Polar OwnOptimizer baseras pa regelbundna matningar éver tid av fem
pulsparametrar. Tva av dessa fem parametrar beraknas i vila, en nar du staller dig upp och tva stdende
stallning. Varje gang du gor testet sparar cykeldatorn pulsvardena och jamfér dem med tidigare
registrerade varden.

Fore testet
Tester for utgangsvirde

Nar du anvander OwnOptimizer for forsta gangen bor du géra sex tester under tva veckor for att bestamma
ditt personliga utgangsvarde. Dessa utgangsvarden bor tas under tva typiska grundtraningsveckor, inte
under veckor med intensiv traning. Utgangsvardena bor inkludera tester som gjorts efter en traningsdag
och efter vilodagar.

Bevaka OwnOptimizer-viarden

Efter att ha tagit fram utgangsvardena, bor du fortsatta att géra testet 2-3 ganger i veckan. Testa dig sjalv
varje vecka pa morgonen efter bade en vilodag och en dag med tung traning, eller efter flera dagar med
tung traning. Ett tredje test kan ev. goras efter en vanlig traningsdag. OwnOptimizer kanske inte kan ge
tillforlitlig information under en traningsfri period eller en period med oregelbunden traning. Om du gor ett
traningsuppehall pa 14 dagar eller mer bor du gora tester for att fa utgangsvarden igen.

Genomfora testet

Testet ska alltid goras under standardiserade/likartade forhallanden for att fa sa tillforlitliga resultat som
mojligt. Vi rekommenderar att testet gérs pa morgonen fore frukost. Féljande grundlaggande krav ska
uppfyllas:

e Tag pa pulssensorn. Mer information finns i Tag pa dig pulssensorn (sida 14).

e Var lugn och avslappnad.

e Du kan sitta avslappnat eller ligga i séngen. Inta alltid samma position nar du gor testet.

e Testet kan goras var som helst: hemma, pa kontoret eller pa gymmet, bara det ar en lugn miljo. Det far
inte forekomma stérande ljud (till exempel fran tv, radio eller telefoner). Se ocksa till att ingen pratar med
dig under testet.

e Undvik att ata, dricka eller roka 2-3 timmar fore testet.

Genomfora testet

Vélj Test > Optimizer > Start > Optimizer Lie Down (Test > Optimering > Starta > Optimering Ligg ner)
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Pilar indikerar att testet pagar. Ror inte pa dig under den forsta delen av testet, vilket tar 3 minuter.

Efter 3 minuter piper cykeldatorn och Optimizer Stand up (Sta upp) visas. Stall dig upp och forbli staende
i 3 minuter.

Efter 3 minuter piper cykeldatorn och testet ar klart.

En siffra och en skriftlig tolkning av resultatet visas. Tryck pa DOWN for att se din snittpuls (slag/min)
liggande (HRrest), din hogsta puls stdende (HRpeak) och snittpulsen stdende (HRstand).

Du kan nar som helst avbryta testet genom att trycka pa STOP. Optimizer Test canceled (optimeringstest
avbrots) visas.

Om cykeldatorn inte kan ta emot din hjartsignal, visas meddelandet Test Failed. Check WearlLink (Testet
misslyckades. Kontrollera WearLink). Da& ska du kontrollera att pulssensorns elektroder ar fuktade och att
baltet sitter at ordentligt.

Efter testet
Att tolka resultatet

Cykeldatorn beraknar fem puls- och pulsvariationsbaserade parametrar. OwnOptimizer-vérdena berdknas
genom att jdmfdra dina senaste resultat med tidigare testresultat. Cykeldatorn visar en skriftlig beskrivning
av din traningsstatus. Beskrivningarna innebérd ges i detalj nedan.

Good Recovery (Fullt dterhamtad) (1)

Din puls ar lagre an normalt. Det visar att du dterhamtat dig bra. Du kan fortsatta trana, inklusive
intensiva traningspass.

Normal State (Normalt tillstand) (2)
Din puls ligger pa en normal niva. Fortsatt tréna och inkludera bade tunga och lattare pass med vilodagar.
Training EFfect (Traningseffekt) (3)

Din puls ar hégre an normalt. Du kan ha intensivtranat under de féregaende dagarna. Du har tva val: 1)
vila eller tréna latt under en eller tva dagar, eller 2) fortsatt intensivtrana i en eller tva dagar och vila
sedan ordentligt. Andra stresskallor sdsom begynnande feber eller influensa kan ge samma resultat.

Steady State (Stabilt tillstand) (4)

Din puls har under en langre period legat pd en normal niva. For att fa effektiv traning bor du bade trana
hart och aterhamta dig ordentligt, och detta ska orsaka variationer i din puls. Dina OwnOptimizer-resultat
visar att du varken tranat intensivt eller haft god aterhamtning under en tid. Gor testet igen efter att ha
vilat eller efter en dag med latt traning. Om aterhamtningen ar effektiv bor ditt resultat vara Good
recovery.

Stagnant State (Stagnerande tillstand) (5)

Din puls ligger fortfarande pa en normal niva. och det har den gjort lange. Resultatet visar att din tréning
inte varit tillackligt intensiv for att du ska utvecklas optimalt. For att effektivt forbattra din kondition bor
du nu lagga till intensivare eller langre tréaningspass i ditt program.

Hard Training (Hard tréning) (6)

Din traning har flera ganger varit hardare an genomsnittligt. Du kan ha tranat hart medvetet. Resultatet
visar 6verbelastning, och du bor férsoka aterhamta dig ordentligt nu. For att bevaka din aterhamtning, gor
testet igen efter en eller tva dagars vila eller ltt traning.

overreaching (Overtraning) (7)

Dina OwnOptimizer-resultat visar att du haft en mycket intensiv traningsperiod under flera dagar eller
veckor. Din puls har kontinuerligt legat pa en hog niva. Detta ar ett allvarligt tecken pa att du bor ta en
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period med total aterhamtning. Ju langre du intensivtranat, desto langre aterhamtning behdéver du. Gor
testet igen efter minst tva dagars aterhamtning..

Sympathetic Overtraining (Sympatisk évertraning) (8)

Dina OwnOptimizer-resultat visar att du har haft en period med mycket intensiv traning under flera dagar
eller veckor, och att du inte aterhamtat dig tillrackligt. Detta har resulterat i 6vertraning. For att aterga till
ett normalt tillstand, vila under en noggrant bevakad aterhamtningsperiod. F6lj din aterhamtning genom
att géra OwnOptimizer testet 2-3 ganger i veckan.

Parasympathetic Overtraining (Parasympatisk évertraning) (9)

Din puls har forblivit 1ag, vilket allmant tolkas som ett tecken pa god aterhamtning. Men andra parametrar
visar pa parasympatisk dvertraning. Du kan ha tranat mycket under en langre period, utan att ha
aternamtat dig tillrackligt. Leta efter andra tecken pa overtraning, som t.ex. férsamrad prestation, dkad
trétthet, humaorsvangningar, sémnstorningar, vidhallande émhet i musklerna och/eller en kansla av att du
ar utbrand eller utsliten. Du kan ocksa ha drabbats av annan stress.

For att drabbas av parasympatisk dvertraning kravs det allméant att man har tranat hart under lang
tidsperiod. For att aterhamta sig fran parasympatisk évertraning maste kroppen helt dterhamta sig och
komma i balans. Aterhamtningen kan ta flera veckor. Du bor inte trana utan vila helt under merparten av
aterhamtningsperioden. Du kan mojligen lagga in nagra dagar med latt aerob traning i korta pass, och bara
tillfalligt inkludera korta, hégintensiva pass.

Du kan ocksa overvaga att trana andra sporter an din huvudsport. Men det bor vara en traningsform du
kanner till och ar bekvam med. Overvaka din aterhamtning genom att géra OwnOptimizer testet 2-3
ganger i veckan. Nar du kanner att du ar i balans igen och dina resultat visar Normalt tillstand eller God
aterhamtning, helst mer an en gang, kan du overvaga att ateruppta din traning. Nar du borjar trana igen,
bérja en ny testomgang med en ny méatning av dina grundvarden.

Innan du férandrar ditt tréningsprogram radikalt bér du analysera igenom dina OwnOptimizer-resultat
tillsammans med din kansla och de eventuella symtom du har. Upprepa OwnOptimizer-testet om du inte
ar saker pa de standardiserade forhallandena. Ett enskilt testresultat kan paverkas av flera olika externa
faktorer, sdsom psykisk stress, latent sjukdom, milj6férandringar (temperatur, h6jd) mm. Du bér uppdatera
dina utgangsvarden minst en gang om aret nar du pabérjar en ny traningssasong.

OwnOptimizer-utveckling
Véalj Test > Optimizer > Trend (Test > Optimering > Utveckling)

Se hur dina OwnOptimizer-varden har utvecklats i menyn Trend (Utveckling). Den innehaller 16 av dina
senaste OwnOptimizer-varden tillsammans med det datum de registrerades. Nar minnet blir fyllt ersatts
det aldsta resultatet automatiskt av nésta resultat.

Det senaste testdatumet, ett diagram med dina resultat och det senaste vardet visas. Tryck pa OK foér att
se en skriftlig beskrivning av dina resultat. Bladdra UP eller DOWN for att se 6vriga resultat.

Radera OwnOptimizer-varde
Vélj Test > Optimizer > Trend (Test > Optimering > Utveckling)

Valj varde och tryck pa och hall in LIGHT. Delete value? No-Yes (Radera varde? Nej/Ja) visas. Bekrafta
med OK.

Reset the Trend File (Nollstédlla Trend-filen)
Vélj Test > Optimizer > Reset (Test > Optimering > Aterstall)

Du kan nollstélla testperioden for OwnOptimizer. Alla testresultat raderas fran minnet. Nar du gor testet
efter en 365-dagars testperiod, eller for forsta gdngen pa 30 dagar, kommer Reset test period? (Aterstall
testperiod?) att visas.

Analysera resultat med programvaran Polar ProTrainer 5
Genom att ladda ner testresultaten till programmet Polar ProTrainer 5 kan du analysera dem pa olika satt,

52 Tester



SVENSKA

samt fa tillgang till mer detaljerad information om din utveckling. Med programmet kan du ocksa gora
diagramjamforelser med tidigare resultat. Resultaten fran Polar OwnOptimizer laddas ner automatiskt till
programvaran nar du laddar ner traningsdata med funktionen Synkronisera.
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10. ANVANDA EN NY PULSSENSOR

Anvanda en ny pulssensor

Din CS600X cykeldator har "kodats in" fér att fungera tillsammans med Polar H3 pulssensor. Det innebar
att din cykeldator endast tar emot signaler fran din pulssensor och din hastighetssensor, och mojliggor
stérningsfri tréning i grupp.

Om du koper en ny pulssensor som ett separat tillbehér maste den kodas ihop med cykeldatorn. Detta tar
bara ett par sekunder.

Se till att gbéra inkodningen fore ett evenemang sa att stérningar forhindras under evenemanget.

Lagga till en ny pulssensor
Tag pa pulssensorn och kontrollera att du inte ar i narheten (40 m) av andra pulssensorer. Valj OK i
klocklage. Cykeldatorn borjar soka efter signalen fran pulssensorn.

Né&r pulssensorn har identifierats kommer New Wearlink Found, Teach new WearLink? (Ny WearlLink har
hittats, Lagga till ny Wearlink?) att visas.

e ValjYes (Ja) for att bekrafta att den ska laggas till. Completed! (Klart!) visas nar kodningen &r klar. Starta
traningsregistreringen genom att trycka pa OK.

e Valj No (Nej) for att avbryta.

@ Din cykeldator hédnvisar till pulssensorn som WearLink .
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11. ANVANDA ETT NYTT TILLBEHOR

Anvanda ett nytt tillbehor

En ny sensor som kopts som ett separat tillbehdr maste introduceras (kodas ihop) i cykeldatorn. Detta
kallas inlarning och tar bara nagra sekunder. Det innebar att din cykeldator endast tar emot signaler fran
din sensor och mojliggér traning i grupp utan stérningar fran andra. Om du képte sensorn och cykeldatorn
som ett set &r sensorn redan inlard att fungera tillsammans med cykeldatorn. Du beh&ver endast aktivera
sensorn i din cykeldator.

@ Du kan programmera en hastighets-, kadens- och effektsensor fdr varje cykelinstélining.

Inldrning av en ny hastighetssensor
Valj Settings > Bike > Bikel1-2-3 > Speed > On-0ff (Instéliningar > Cykel > Cykel 1/2/3 > Hastighet >
Pa/Av).Teach new sensor? (Lagga till ny sensor?) visas

e Se till att du inte ar i narheten (40 m) av andra hastighetssensorer. Valj Yes (Ja) for att bekrafta att den
ska laggas till. Start test drive (Starta test) visas. Rotatera vevarmen nagra ganger sa att sensorn
aktiveras. En blinkande réd lampa anger att sensorn ar aktiverad. Completed! (Klart!) visas nar kodningen
ar klar. Cykeldatorn &r nu redo att ta emot information fran hastighetssensorn.

e Valj No (Nej) for att avbryta programmeringen, och den sedan tidigare inlagda hastighetssensorn tas i bruk.

@ Nér hastighetssensorn en gang har kodats ihop med cykeldatorn kommer den att kdnnas igen &ven om sensorn har
varit avstangd. Nar hastighetssensorn aktiveras kommerTeach new sensor? (Ldgga till ny sensor?) att visas.
Valj NO (Nej). Om YES (Ja) véljs pabdrjas kodsdkningen igen.

For videohandledning, ga till http://www.polar.com/en/polar_community/videos.

Inldrning av en ny kadenssensor*
Valj Settings > Bike > Bikel-2-3 > Cadence > On-0ff (Instéllningar > Cykel > Cykel 1/2/3 > Kadens >
Pa/Av). Teach new sensor? (L3agga till ny sensor?) visas

e Se till att du inte ar i narheten (40 m) av andra kadenssensorer. Valj Yes (Ja) for att bekrafta att den ska
laggas till. Start test drive (Starta test) visas. Rotatera vevarmen nagra ganger sa att sensorn aktiveras.
Ett blinkande rétt ljus visar att sensorn &r aktiverad. Completed! (Klart!) visas nar kodningen ar klar.
Cykeldatorn ar nu redo att ta emot kadensdata.

e ValjNo (Nej) for att avbryta programmeringen. Cykeldatorn kan inte mata kadensdata.

@ Nér kadenssensorn en gang har kodats ihop med cykeldatorn kommer den att kdnnas igen dven om sensorn har
varit avstangd. Nar kadenssensorn sétts pa nasta gang kommerTeach new sensor? (Ligga till ny sensor?) att
visas. Valj NO (Nej) och cykeldatorn gar dver till on-0FF (Pa/Av)-lage. Valj ON (Pa) for att aktivera
kadenssensorn. 0m YES (Ja) véljs pabdrjas kodsdkningen igen.

For videohandledning, ga till http://www.polar.com/en/polar_community/videos.

Inldrning av en ny Power Output Sensor*
Valj Bike > Bike1-2-3 > Power > Ons0ff (Cykel > Cykel 1/2/3 > Effekt > Pa/Av). Teach new sensor?
(Lagga till ny sensor?) visas.

e Se till att du inte ar i narheten (40 m) av andra effektsensorer. Valj Yes (Ja) for att bekrafta att den ska
laggas till. Start test drive (Starta test) visas. Rotatera vevarmen nagra génger sa att sensorn aktiveras.
Ett blinkande rott ljus visar att sensorn &r aktiverad. Completed! (Klart!) visas nar kodningen ar klar.
Cykeldatorn &r nu redo att ta emot effektdata.

e Valj No (Nej) for att avbryta programmeringen. Cykeldatorn kan inte mata effektdata.
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Nér effektsensorn en gang har kodats ihop med cykeldatorn kommer den att kannas igen dven om sensorn har
varit avstangd. Nar hastighetssensorn sétts pa kommerTeach new sensor? (Ldgga till ny sensor?) att visas.
Vélj NO (Nej). Cykeldatorn dvergar till on-0FF (Pa/Av)-laget. Den effektsensor som senast lagts till kommer att
anvéndas. OmYes (Ja) véljs pabdrjas kodsékningen igen.

For videohandledning, ga till http://www.polar.com/en/polar_community/videos.

Lagga till en ny G5 GPS-sensor*
Sl& pad G5 GPS-sensorn och vélj sedan Settings > Features > 6PS > On (Installningar > Funktioner > GPS
> Pa) i din cykeldator. Teach new sensor? (Lagga till ny sensor?) visas.

e VailjYes (Ja) for att bekrafta att den ska laggas till. Completed! (Klart!) visas.
e ValjNo (Nej) for att avbryta. Cykeldatorn kan inte méata GPS-data.

For videohandledning, ga till http://www.polar.com/en/polar_community/videos.

*Tillbehorssensorer kravs
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12. BAKGRUNDSINFORMATION

Polar Sportzoner

Med Polar sportzoner erbjuds en ny effektivitetsniva for pulsbaserad traning. Traningen delas in i fem
sportzoner berdknade utifran procent av din maxpuls. Med sportzoner kan du enkelt valja och évervaka
traningens intensitet, och félja Polars sportzonsbaserade traningsprogram.

Tréningszon Intensitet i % av  Tréaningstid Traningseffekt
maxpuls och
slag/min

EFfekt: Maximal eller ndstan maximal
andnings- och muskelanstrangning.

90-100 % Upplevs: Mycket utmattande for andning och

171-190 thst 5 muskler.
slag/min minuter Rekommenderas for : Mycket erfarna
cyklister med bra kondition. Endast korta
intervall, vanligtvis den slutliga forberedelsen
infor korta cykeltillfallen.
HARD Effekt: Okad méjlighet att uppratthalla hég
troskeluthallighet.
80-90 % Upplevs: Muskular utmattning och tung
&) 152-172 2-20 minuter andning.
slag/min Rekommenderas Fir : Erfarna cyklister som
tranar aret runt, varierad langd. Blir viktigare
under sdsongen fore tavlingarna.
MEDEL Effekt: Okar det allmanna traningstempot, gor
mattliga anstrangningar lattare och okar
(% 70-80% Uppleys: Cykﬁgg kr:llgtlit%trzn’.[empo och med
133-152 10-60 minuter ' .
slag/min konstan’ahog kad_ens. )
Rekommenderas far : Cyklister som ndrmar
sig traningshandelser eller vill dka sin
prestanda.
LATT Effekt: Okar den allmanna konditionen,
aterhamtningen och metabolismen.
60-70 % Upplevs: thagligt och _Ia’tt, Iég"
&) 114-133 6Q—300 muskelbelastning och kardiovaskular
slag/min minuter belastning. ) .
Rekommenderas Fir : Alla som tranar langa
traningspass under grundtraningsperioder och
for att dterhamta sig under tavlingssésongen.
MYCKET LATT EFfekt: Hjalper kroppen att varma upp, varva
50-60 % ner och aterhamta sig.
104-114 20-60 minuter Upplevs: Mycket |4tt, lite anstrangning.
slag/min Rekommenderas Fir : For dterhamtning och

nedvarvningstraning under traningssasongen.

Maxpuls ar uppskattat enligt formeln (220-alder). Exempel: 30 ar, 220-30=190 slag/min.

Cykling i sportzone 1 (Very light) (sportzon 1 [mycket L&tt)) gors med mycket l3g intensitet.
Huvudprincipen for traning ar att din prestationsférmaga forbattras efter traning under
aterhamtningsfasen, och inte bara under traning. Du kan paskynda din aterhamtning med lagintensiv
traning.
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Sportzone 2 [Light] (sportzon 2 (Latt)) &r for uthallighetstréaning, en mycket viktig del av all traning.
Cykling i denna zon &ar 14att och aerob. Langa traningspass med lag intensitet ger effektiv
energiforbranning. Framsteg kraver uthallighet.

Syreupptagningsférmagan forbattras i Sportzone 3 (Moderate) (sportzon 3 (Medel)). Traningens intensitet
ar hogre an i Sportzon 1 och 2, men fortfarande huvudsakligen aerob. Traning i Sportzon 3 kan t.ex. besta
av intervaller foljda av aterhamtning. Cykling i denna zon &r sarskilt effektivt for att forbattra
blodcirkulationen i hjartat och skelettmuskulaturen.

Om ditt mal ar att tavla med din toppotential, ska du trana i sportzon 4 (sportzon 4) och 5. | dessa zoner
ar cyklingen anaerob i intervaller pa upp till 10 minuter. Ju kortare intervall, desto hogre intensitet.
Tillracklig aterhamtning mellan intervallet an mycket viktigt. Traningsmonstret i zon 4 och 5 &r utformat
for att ge topprestationer.

Néar du cyklar i en speciell sportzon ar zonens mitt ett bra mal men hall inte pulsen pa exakt samma niva
hela tiden. Traningsintensiteten, aterhamtningsnivan, yttre faktorer, m.m. kommer alla att paverka pulsen.
Det ar darfor viktigt att ta hansyn till subjektiva trétthetskanslor, och att anpassa traningen darefter.

Ett enkelt satt att anvédnda sportzoner &r att anvanda sig av pulszoner. Mer information finns i Planera din
traning (sida 12).

N&r passet &r slut visas hur l&nge du har tranat i de olika sportzonerna. Oppna visningen Weekly
(Veckosummering) for de sportzoner du har trénat i och hur lange du har tranat i var och en. Med
programvaran Polar ProTrainer 5 har du upp till 10 sportzoner fér att battre passa dina traningsbehov och
din pulsreserv.

OwnZone-traning

Cykeldatorn faststaller automatiskt en individuell och saker intensitetsniva for din traning: din OwnZone.
Polars unika OwnZone-funktion faststaller ditt personliga tréningszon fér aerob tréning. Funktionen leder
dig genom uppvarmningen och utgar fran din nuvarande fysiska och mentala kondition. For de flesta vuxna
motsvarar OwnZone 65-85 % av maxpuls.

Du kan hitta din OwnZone pa 1-5 minuter nar du varmer upp genom att cykla, jogga eller trana pa annat
satt. Idén ar att borja trana langsamt med lag intensitet och gradvis 6ka intensiteten for att hoja pulsen.
OwnZone har utvecklats for friska personer. Vissa héalsotillstand kan gora att det inte gar att faststalla
OwnZone baserad pa hjartfrekvensvariation. Detta innefattar hogt blodtryck, hjartarytmi och vissa
mediciner.

Att lyssna pa och tolka kroppens signaler vid fysisk anstrangning ar en viktig del av att komma i form.
Eftersom olika typer av uppvarmning anvands vid olika typer av traning, och fysisk och mental kondition
kan variera fran dag till dag (till exempel pa grund av stress eller sjukdom), garanterar
OwnZone-funktionen att du tranar i den effektivaste pulszonen fér den aktuella traningstypen och dagen.

Mer information om hur du faststaller din OwnZone finns iFaststalla din OwnZone (sida 23).

Maxpuls

Maxpulsen (HR,,,) ar det hogsta antalet slag per minut hjéartat kan sla under maximal fysisk anstrangning.
Det ar individuellt och beror pa alder, arftliga faktorer och kondition. Det kan ocksa variera for olika typer
av sporter. Maxpulsen anvands for att uttrycka trédningens intensitet.

Faststdlla maxpuls
Din maxpuls kan faststallas pa flera satt.

Det béasta ar att mata din maxpuls kliniskt. En belastningstest som &vervakas av en kardiolog eller
traningsfysiolog utférs vanligtvis pa ett I6pband eller cykel.

Du kan mata din maxpuls sjalv, genom att gora ett falttest med en tréaningspartner.

En uppskattning eller ett HRmax-p-vérde som beraknar din maxpuls kan fas om du goér Polar Fitness Test.
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Den vanligen anvanda formeln: 220 - alder, men studier visar att denna metod inte ar sarskilt exakt, i
synnerhet for aldre personer eller fér dem som varit valtranade i manga ar.

Om du har tranat hart under de senaste veckorna och vet att du utan problem kan na din maxpuls, kan du
gora ett test for att sjalv faststalla din individuella maxpuls. Vi rekommenderar att du har en
traningspartner med dig under testet. Prata med din lakare innan du genomfor testet om du ar osaker.

Ett exempel pa ett enkelt maxpulstest.
Steg 1: Varm upp i 20 minuter pa plant underlag och 6ka tempot till ditt normala tempo.

Steg 2: Valj en backe som det tar langre an tva minuter att springa upp for. Cykla upp foér backen en gang
i ett tempo som du kan halla i 20 minuter. Ta dig ner igen.

Steg 3: Cykla upp for backen igen i ett tempo som du kan halla i 10 minuter. Notera din hogsta puls. Din
maxpuls ligger c:a 10 slag 6ver detta varde.

Steg 4: Spring nerfor backen och lat samtidigt pulsen sjunka med 30-40 slag/minut.

Steg 5: Spring upp for backen igen i ett tempo du kan halla i en minut. Férstk cykla halvvags upp for
backarna. Notera din hogsta puls. Du ligger nu néara din maxpuls. Anvand detta varde som maxpuls nar du
stéller in traningszoner.

Steg 6: Se till att varva ner ordentligt i minst 15 minuter efter testet.

Puls i sittande stallning

HRg;; ar din snittpuls nér du ar helt stilla (dvs. sittande). For att enkelt faststéalla HRg;;, tag pa
pulssensorn, sitt ner och utfér ingen fysisk aktivitet. For att fa ett mer tillforlitligt varde kan du upprepa
proceduren flera ganger och berakna medelvardet.

Pulsreserv

Pulsreserven (HRR) &r differensen mellan maxpuls (HR,,,) och vilopuls (HR,es)*. Pulsreserven kan
anvands som alternativ metod for att rakna ut puls under traning. Det &r inom det omréadet pulsen ligger
beroende pa anstrangningsniva. Pulsreserven motsvarar ungefér syreupptagningsformagan (VO,R).

Puls under traning kan beraknas med Karvonens formel**. Addera procentandelen av pulsreserven till
vilopulsen.

Traningspuls = % av malintensiteten (HR 2 — HRyest) + HRyest
Exempel:

Malintensitet 70 % av pulsreserven for en person med maxpuls 201slag per minut och vilopuls 50 slag
per minut

Traningspuls= 70 % (201-50) + 50
Traningspuls=156 slag/min

For en exakt puls behéver du ett exakt varde fér maxpuls och vilopuls. Om du anvander av en
uppskattad/berdknad maxpuls ar alla pulsvéarden for trdningszoner ungefarliga.

*| Polar CS600X cykeldator mats vilopulsen sittande (HRg;;). Det gors av praktiska skal eftersom HR;
anvéands for noggrannhet i berakningen av energiférbrukning. HR;; motsvarar den laga intensitet som olika
lagintensiva aktiviteter kan jamféras med.

**Karvonen M, Kentala K, Mustala O. The effects of training on heart rate: a longitudinal study. Ann Med
Exp Biol Fenn 1957; 35: 307-315.

Hjartfrekvensvariation

Hjartfrekvensen varierar med varje hjartslag. Hjartfrekvensvariationen (HRV) &r variationen i intervallet

Bakgrundsinformation 59



SVENSKA

mellan pulsslagen, dven kallat R-R intervall.

845 745 812 732

=

HRV visar variationen i puls runt en genomsnittlig puls. En genomsnittlig puls pa 60 slag/minut innebar
inte att intervallet mellan flera hjartslag i féljd ar exakt 1,0 sek., utan de kan variera mellan 0,5 sek. och
2,0 sek.

HRV paverkas av den aeroba konditionen. Ett valtranat hjarta har ofta en stor HRV i vila. Andra faktorer
som paverkar HRV ar alder, gener, kroppsposition, tid pa dagen och allméan halsa. Vid traning minskar
HRV med 6kande puls och traningsintensitet. HRV minskar ocksad under perioder med mental stress.

HRV styrs av det autonoma nervsystemet. Parasympatisk aktivitet minskar pulsen och ékar HRV, medan
sympatisk aktivitet 6kar pulsen och minskar HRV.

HRV anvands i funktionerna OwnZone, Ownlndex och i OwnOptimizer. Det kan ocksa Gvervakas med
cykeldatorn. Om din HRV &ndras vid en viss cykelhastighet och puls kan det indikera en férdndring i din
traningsbelastning och stress.

R-R registrering

R-R registrering lagrar enskilda pulsvérden, d.v.s. tidsintervallet mellan varje hjértslag. Denna information
visas ocksd som momentan puls i slag per minut for registrerade varden.

Nar varje enskilt hjartslag registreras, kan ocksa extraslag och artefakter ses. Vi rekommenderar att
kontaktgel anvénds for att optimera kontakten mellan din hud och pulssensorn. Varden som tolkas som
felaktiga i pulsdata kan justeras och korrigeras med programvaran Polar ProTrainer 5.

Mer fakta och know-how for att 6ka din 16pning finns i Polar artikelbibliotek
[http://www.polar.com/en/training_with_polar/training_articles].
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13. KUNDSERVICE

Skotsel och underhall

Som med alla elektroniska enheter ska du vara aktsam nar du anvéander Polar cykeldator. Informationen
nedan kan hjalpa dig att uppfylla kraven for att garantin ska galla och att ha noje av din produkt i manga
ar framover.

Skotsel av produkten

Sandare: Lossa sandaren fran baltet efter varje anvandning och torka den med en mjuk handduk. Rengor
sandaren med en mild tvallésning nar det behovs. Anvand aldrig alkohol eller slipande material (t.ex.
stalull eller rengoringskemikalier).

Bélte: Skolj baltet under rinnande vatten efter varje anvéandning och hang upp for att torka. Rengér baltet
varsamt med en mild tvallésning nar det behdvs. Anvand inte en fuktighetsbevarande tval, da den kan
lamna kvar rester pa baltet. Baltet far inte blotlaggas, strykas, kemtvattas eller blekas. Tanj inte pa baltet
och bdj inte elektrodytorna kraftigt.

@ Kontrollera etiketten pa ditt bélte fir att se om det kan maskintvattas. Lagg aldrig in béltet eller sandaren i en
torktumlare!

Cykeldator och sensorer: Hall cykeldatorn och sensorerna rena. For att bibehalla vattenresistensen, tvatta
inte cykeldatorn eller sensorerna med hogtryckstvatt. Rengér dem med vatten och mild tvallésning och
skolj dem med rent vatten. Sank inte ned dem i vatten. Torka dem noga med en mjuk handduk. Anvand
aldrig alkohol eller material med slipverkan, exempelvis stalull eller kemikalier.

Forvara din cykeldator och sensorer kallt och torrt. De ska inte férvaras i fuktig miljo, i tattslutande
material som inte andas (sasom en plastpase eller sportvaska) eller tillsammans med elektriskt ledande
material (t.ex. en bldt handduk). Cykeldatorn och de kompatibla sensorerna &r vattenresistenta, och kan
anvandas nar det regnar. Utsatt inte cykeldatorn fér direkt solljus i langre perioder, som t.ex. inne i en bil
eller monterad pa cykeln.

Se till att cykeldatorn och sensorerna inte utsatts fér harda slag eftersom detta kan skada
sensorenheterna.

Service

Under de tva ar da garantin galler rekommenderar vi att du endast later en auktoriserad Polar
serviceverkstad utféra service. Garantin tacker inte skador eller féljdskador som harrér fran service som
inte auktoriserats av Polar Electro. For ytterligare information, se Begrénsad internationell Polar-garanti
(sida 68)

Fér kontaktinformation och alla adresser till Polar Service Center, bes6k www.polar.com/support
[http://www.polar.com/support] och landsspecifika webbplatser.

Registrera din Polar-produkt pa http://register.polar.fi/ sa att vi kan fortsatta forbattra och utveckla vara
produkter och tjanster sa att de battre maoter dina behov.

@ Anvéndarnamnet fir ditt Polar-konto ar alltid din e-postadress. Samma anvéandarnamn och ldsenord géller fir
Polars produktregistrering, polarpersonaltrainer.com, Polars diskussionsforum och vid registrering av nyhetsbrev.

Byta bhatterier
Cykeldatorn CS600X och Polar H3 pulssensor har bada ett utbytbart batteri. For att byta batteri sjalv, f6lj
instruktionerna noga i Byte av cykeldatorns batteri..

Batterierna i hastighets- och kadenssensorerna for cykel kan inte bytas. Polars hastighets- och
kadenssensorer for cykel ar forseglade for att maximera den mekaniska livslangden och tillférlitligheten.
Sensorerna har batterier med lang livslangd. Kontakta auktoriserade Polar servicecenter eller aterforsaljare
for att kdpa en ny sensor.
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For instruktioner om hur du byter batteriet i systemet Polar LOOK Kéo Power, se bruksanvisningen for
Polar LOOK Kéo Power.

G5 GPS-sensorn har ett internt, uppladdningsbart batteri som inte kan tas ur. Se bruksanvisningen till G5
GPS-sensorn for instruktioner om hur du laddar batteriet.

@ Forvara batterierna pa behdrigt avstand fran barn. Om batterierna svaljs, kontakta lakare omedelbart. Batterierna
ska atervinnas enligt lokala bestammelser,

A

Explosionsrisk férekommer om batteriet byts ut mot fel typ av batteri.

Byte av cykeldatorns batteri.
For att du ska kunna byta cykeldatorns batteri behdver du ett mynt och ett nytt batteri (CR 2354).

1. Anvénd ett mynt fér att 6ppna batterilocket
genom att trycka latt och samtidigt vrida moturs.

2. Ta bort batterilocket. Batteriet sitter fast i locket,
som lyfts forsiktigt. Ta ur batteriet och satt i ett
nytt. Var forsiktig sa att du inte skadar
kontakterna i locket.

3. Placera batteriets pluspol (+) mot locket och den
negativa polen.

4. Lockets tatningsring ar ocksa fast i locket. Byt ut
tatningsringen om den &r skadad. Innan du
stanger locket kontrollerar du att tatningsringen
inte ar skadad och att den sitter ordentligt fast i
skaran.

5. Satt fast locket och vrid det medurs med ett
mynt till 1dget CLOSE. Se till att locket &r
ordentligt stangt!

Batteriet tar slut fortare om du anvander bakgrundsbelysningen ofta. Vid kall vaderlek kan indikatorn for
lag batteriniva visas och sedan férsvinna igen nar du kommer in i en varmare omgivning. For att
batterilocket ska halla sa lange som mojligt ska du bara 6ppna det nar du behéver byta batteri. Vid
batteribyte ska du kontrollera att férseglingsringen inte &r skadad och byta ut den om den ar det.

For videohandledning om hur du byter batteri, ga till www.polar.com/en/polar_community/videos
[http://www.polar.com/en/polar_community/videos].

@ Det finns ingen separat videohandledning fir att byta batteri pa CS600X, se dérfor videohandledningen for att
byta batteri pa €S200, men observera att det ar en annan batterityp.

Pulssensorns batteri
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Byta batteri pa Polar H1/H2/H3 pulssensor

1. Lyft upp batterilocket genom att anvanda
spannet pa baltet.

2. Ta bort det gamla batteriet fran batterifacket
med en pinne i lamplig storlek, t.ex. en
tandpetare. Ett verktyg av icke-metall ar att
féredra. Var forsiktig sé att inte batterilocket
skadas.

3. Satti ett nytt batteri i batterilocket med den
negativa polen (-) utat. Se till att
forseglingsringen passar i sparet for att sakra
sandarens vattenresistens.

4. Rikta in kanten pa batterilocket med skaran pa
sandaren, och tryck batterilocket pa plats. Du
ska hora ett klick.

For videohandledning om hur du byter batteri, ga till www.polar.com/en/polar_community/videos
[http://www.polar.com/en/polar_community/videos].

Byta batteri pa Polar WearLink+ pulssensor

1. Oppna batterilocket med ett mynt genom att
vrida moturs till OPEN.

2. Satt i batteriet (CR2025) pa insidan av locket
med den positiva (+) sidan mot locket. Se till att
forseglingsringen passar i sparet for att sakra
sandarens vattenresistens.

3. Sétt tillbaka locket pa sandarenheten.

4. Anvéand mynten for att vrida tillbaka till CLOSE*.

Oppna endast locket nar du byter batteri for att det
ska halla sa lange som mojligt och se till att
forseglingsringen inte ar skadad. Den ska i sa fall
bytas ut mot en ny.

For videohandledning om hur du byter batteri, ga till www.polar.com/en/polar_community/videos
[http://www.polar.com/en/polar_community/videos].

@ Dessa firseglingsringar kan kopas fran Polar-auktoriserade serviceverkstader. | USA och Kanada finns extra
forseglingsringar att kipa hos auktoriserade Polar-serviceverkstéder. | USA kan forseglingsringarna dven kopas pa
www.shoppolar.com [http.//www.shoppolar.com]. G4 till www.polar.com [http://www.polar.com] fér att
hitta ditt lands shoppolar online-butik.

Sakerhetsforeskrifter

Storningar under traning
Elektromagnetiska storningar och traningsutrustning.

Stoérningar kan férekomma nara mikrovagsugnar och datorer. WLAN-basstationer kan ocksa orsaka
stérningar under traning med CS600X. Undvik felaktiga registreringar eller avlasningar genom att hélla dig
pa avstand fran mojliga stérningskallor.

Traningsutrustning med elektroniska eller elektriska komponenter, som t.ex. LED-displayer, motorer och
elektriska bromsar, kan orsaka atmosfariska stérningar. Prova féljande for att 16sa dessa problem:

1. Ta bort pulssensorn fran brostkorgen och anvand traningsutrustningen som du normalt skulle géra.
2. Flytta runt cykeldatorn tills du hittar en plats dar inte strévarden visas eller hjartsymbolen blinkar.
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Stérningarna ar ofta starkast alldeles framfér utrustningens displaypanel medan vanster och héger sida av
displayen éar relativt fria fran storningar.

3. Satt tillbaka pulssensorn runt bréstkorgen och hall cykeldatorn i detta storningsfria omrade sa langt det ar
mojligt.

Om cykeldatorn fortfarande inte fungerar med traningsutrustningen kan den elektriskt vara for bullrig for
tradlos pulsmatning.

Minimera riskerna vid traning

Tréaning kan medfdra vissa risker. Innan du bérjar trana regelbundet rekommenderar vi att du besvarar
foljande fragor angdende ditt halsotillstand. Om du svarar ja pa nagon av dessa fragor rekommenderar vi
att du kontaktar en ldkare innan du bdérjar tréna.

e Har du varit fysiskt inaktiv de senaste 5 aren?

e Har du hdgt blodtryck eller hogt kolesterolvarde?

e Har du nagra symtom pa sjukdom?

e Tar du blodtrycks-eller hjartmediciner?

e Har du tidigare haft problem med andningen?

e Befinner du dig i rehabilitering efter en allvarlig sjukdom eller medicinsk behandling?

e Anvander du pacemaker eller annat elektroniskt implantat?

e Roker du?

e Ardu gravid?

Observera att forutom intensitetsnivan i traningen kan medicinering for hjartproblem, blodtryck,
psykologiska tillstand, astma, andning etc., saval som vissa energidrycker, alkohol samt nikotin ocksa
paverka hjartfrekvensen.

Det ar viktigt att du lyssnar pa kroppens signaler nar du tranar. Om du upplever plotslig smarta eller
kanner dig extremt tr6tt ndr du tranar, rekommenderar vi att du avbryter triningen eller 6vergar till en
lugnare intensitet.

Obs! Bar du pacemaker kan du anvanda Polars traningsdatorer. Teoretiskt ska interferens mellan
Polarprodukter och pacemaker inte vara mojlig. Inga rapporter foreligger heller som visar att nagon
nagonsin upplevt en sadan interferens. Vi kan emellertid inte garantera att alla vara produkter passar till
alla pacemakers eller andra implantat pa grund av det stora antalet implantat pa marknaden. Om du
kanner dig tveksam eller upplever ovanliga sensationer nar du anvander produkter fran Polar ska du
kontakta din lakare eller tillverkaren av ditt elektroniska implantat fér rad och anvisningar.

Om du har nagon form av kontaktallergi eller om du missténker en allergisk reaktion p.g.a. anvdandning av
produkten, boér du kontrollera de material som anges i Tekniska specifikationer. For att undvika allergiska
reaktioner p.g.a. sandarbéltet kan du bara det utanpa en tréja. Fukta emellertid tréjan ordentligt under
elektroderna for att matningen ska fungera utan stérningar.

Den kombinerade effekten av fukt och intensiv skavning kan leda till att en svart férg avges fran sandarens yta,

vilket eventuellt kan orsaka fldckar pa ljusa kldder. Om du anvander insektsmedel pa huden bdr du se till att det
inte kommer i kontakt med pulssensorn.

Teknisk specifikation

Cykeldator

Cykeldatorn ar en laserprodukt i klass 1

Batterilivslangd: Ungefar 1 &r (1 tim/dag, 7 dagar i veckan)

Batterityp: CR 2354

Férseglingsring: 0-ring 20,0 X 1,0; material: silikon

Driftstemperatur: Driftstemperatur -10 °C till +50 °C

Material: Termoplastisk polymer

Noggrannhet: Battre 4n + 0,5 sekunder/dag vid en temperatur pa 25 °C
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Pulsmétningens tillforlitlighet:

Métintervall for puls:

Visningsintervall for aktuell hastighet:

Visningsintervall for hojd:
Upplésning av hdjd, uppfor:

Cykeldatorns maxvarden

Maximalt antal filer:
Maximal traningstid/fil:
Maximalt antal varvtider/fil:
Totalstracka:

Total tréningstid:

Total kaloriforbrukning:

+ 1 % eller 1 slag per minut, beroende pa vilket som &r hogst.

Definitionen avser stabila tillstand.
15-240

0-127 km/h eller 0-75 miles/h
-550m ... +9 000 m

5m

99

99h 59 min59s

99

999 999 km / 621 370 miles
9999h59minhH9s

999 999 kcal

SVENSKA

Totalt antal traningspass: 9999

Total uppstigning: 304 795 m /999 980 ft
Sandarenhet

Batteriets livslangd for Polar H3 pulssensor: 1600 h

Batterityp: CR2025

Forseglingsring: 0-ring 20,0 X 0.90; material: silikon
Driftstemperatur: -10 °C till +40 #

Material i sdndare: Polyamid

Material i elektrodbalte: 38 % polyamid, 29 % polyuretan, 20 % elastan, 13 % polyester

Polar ProTrainer 5™

Systemkrav: PC
Windows® 2000/XP (32bit), Vista
IrDA-kompatibel port (extern IrDA-enhet eller en intern Ir-port)
Dessutom méste din dator ha en Pentium Il 200 MHz-processor eller
snabbare, en skdrm med SVGA eller hogre upplésning, 50 MB
harddiskutrymme och en CD-rom-enhet.

Polar WebLink med IrDA-kommunikation

Systemkrav: PC
Windows® 2000/XP/Vista 32/64-bit eller Windows 7 32/64-bit
IrDA-kompatibel port (extern IrDA-enhet eller en intern Ir-port)

Polar cykeldator visar dina prestationsindikatorer. Den har utformats for att ange den fysiologiska
anstrangningen och aterhamtningen under och efter ett traningspass. Den mater ocksa hastighet och
stracka nar du cyklar med en Polar Hastighetssensor. Polar G5 GPS-sensor mater hastighet, stracka och
position (koordinater). Polar Kadenssensor &r utvecklad for att méta trampfrekvens nér du cyklar. Systemet
Polar LOOK Kéo Power ar utvecklat for att méata effektutvecklingen nar du cyklar. Ingen annan anvandning
avses.

Polar cykeldator bér inte anvandas for inhamtning av milj6faktorer som kréver yrkesmaéssig eller industriell
precision. Den bdr inte heller anvandas for att inhamta varden under aktiviteter uppe i luften eller under
vatten.

Vattenresistensen hos Polars produkter har testats i enlighet med den internationella standarden IEC
60529 IPx7 (1 m, 30 min, 20 °C). Produkterna ar indelade i fyra kategorier beroende pa deras
vattenresistens. Titta pa markningen pa baksidan av din Polar-produkt och jamfér med tabellen nedan.
Observera ett dessa definitioner inte nédvandigtvis galler for produkter fran andra tillverkare.

Markning pa baksidan
Vattentat IPX7*

Typ av vattenresistens

Ej lamplig for bad eller simning. Skyddad mot
vattenstank och regn. Tvatta inte med
hogtryckstvatt.
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Markning pa baksidan Typ av vattenresistens

Vattenresistent** Ej lamplig for simning. Skyddad mot vattenstank,
svett, regn osv. Tvatta inte med hogtrycksvatt.

Vattenresistent 30 m/50 m*** Lamplig vid bad och simning

Water resistant 100 m Lamplig vid simning och snorkling (utan
lufttankar)

* Systemet Polar LOOK Kéo Power
** Polar CS600X cykeldator, CS hastighetssensor W.I.N.D. och CS kadenssensor W.I.N.D.

*** Polar H3 pulssensor ar vattenresistent 30 m, men den mater inte pulsen i vatten.

Fragor och svar (FAQ)
Vad gor jag om

... batterisymbolen och Battery low (Lag batteriniva) visas?

Det forsta tecknet pa att batteriet haller pa att ta slut ar att batteriindikatorn visas. Men symbolen kan
visas nar det ar kallt. Symbolen forsvinner sa fort du kommer in i normal temperatur. Nar symbolen visas
ljuder cykeldatorn och bakgrundsbelysningen slacks. Mer information om byte av batteriet finns i Skétsel
och underhéll (sida 61).

... jag inte vet var jag befinner mig i menyn?
Tryck pa och hall in STOP tills klockslaget visas.
... inget hiander nér jag trycker pa knapparna?

Nollstall cykeldatorn genom att samtidigt trycka pa alla sidoknappar i 2 sekunder. Efter nollstallningen,
tryck pa den roda knappen, Start with bike settings (Borja med cykelinstéllningar) visas. Du kan antingen
godkanna cykelinstallningarna med OK eller dndra cykelinstaliningarna. Da visas Basic Settings
(Grundlaggande instéllningar). Stéll in klockslag och datum, dvriga instéllningar har sparats. Mer
information finns i Grundinstaliningar (sida 9) och Mata hjulstorleken (sida 8). Om du inte vill andra
resten av installningarna kan du hoppa éver dem genom att trycka pa och halla in STOP. Alla tréaningsdata
har sparats.

... cykeldatorn inte mater kaloriférbrukningen?

Forbrukade kalorier berédknas bara néar du bar séndaren och alla grundinstallningar ar korrekt gjorda. Mer
information finns i Grundinstéllningar (sida 9).

... en annan person med cykeldator eller pulsmatare orsakar stérningar?
Se Sakerhetsforeskrifter (sida 63).

.. de avlasta pulsvdrdena ar instabila, extremt hoga eller visar noll (00)?

e Se till att cykeldatorn inte befinner sig langre bort an 40 m fran pulssensorn.

e Kontrollera att pulssensorns bélte inte lossnat under traningen.

e Kontrollera att insydda elektrodytor i kladesplagg sitter at och inte glappar.

e Kontrollera att pulssensorns/kladesplaggets elektrodytor ar fuktiga.

e Kontrollera att pulssensorn/kladesplagget ar rena.

e Kontrollera att det inte finns ndgon annan pulssensor inom 40 meters avstand.

e Starka elektromagnetiska signaler kan ge upphov till instabila varden. For ytterligare information, se
Sakerhetsforeskrifter (sida 63).

e Om den felaktiga pulsavlasningen fortsatter trots att du flyttat dig bort fran stérningskallan ska du minska
din hastighet och kontrollera pulsen manuellt. Om du anser att den motsvarar den héga avlasningen pa
displayen kan du uppleva hjartarrytmi. De flesta fall av arrytmi &r inte allvarliga, men kontakta din lakare i
alla fall.
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Ett hjartproblem kan ha andrat din EKG-vagform. Kontakta i sa fall en lakare.

...Check WearLink! (Kontrollera WearLink!) visas och din cykeldator kan inte hitta din pulssignal?
e Se till att cykeldatorn inte befinner sig langre bort an 40 m fran pulssensorn.

e Kontrollera att pulssensorns bélte inte lossnat under traningen.

e Kontrollera att insydda elektrodytor i kladesplagg sitter at och inte glappar.

e Kontrollera att pulssensorns/kladesplaggets elektrodytor ar fuktiga.

e Kontrollera att pulssensorns/klddesplaggets elektrodytor ar rena och oskadade.

e Om pulsmatningen inte fungerar med kladesplagget, prova med en Soft strap istéllet. Om din puls
detekteras med baltet ligger problemet férmodligen i kladerna. Vanligen kontakta tillverkaren/férsaljaren av
aktuellt plagg.

e Om du har provat ovanstaende atgarder, och meddelandet fortfarande visas och pulsmétningen inte
fungerar, kan det vara batteriet i pulssensorn som ar slut. For ytterligare information, se Skoétsel och
underhall (sida 61).

@ Din cykeldator héanvisar till pulssensorn som WearLink .

...New WearlLink found. Teach new Wearlink? (Ny WearLink har hittats, Lagg till ny Wearlink?) visas?

Om du har képt en ny pulssensor som ett tillbehér, maste den programmeras in pa cykeldatorn. For
ytterligare information, se Anvanda en ny pulssensor (sida 54).

Om pulssensorn du anvander fanns med i produktpaketet och denna text visas pa displayen, kan det vara
sa att din cykeldator fangar upp signaler fran en annan pulssensor. Om sa ar fallet, kontrollera at du bar
din egen pulssensor, att elektroderna ar fuktade och att pulssensorns balte inte lossnat. Om meddelanden
anda visas ar batteriet i din pulssensor slut. For ytterligare information, se Skotsel och underhall

(sida 61).

...Check Speed! (Kontrollera hastighet!) visas?
Mer information finns i bruksanvisningen till hastighetssensor W.1.N.D.
...Check Power! (Kontrollera effekt!) visas?*

Kontrollera att effektsensorns funktion aktiverats i cykeldatorn. Om den aktiverats ska cykelsymbolen visas
pa datorn. Se till att effektsensorn ar placerad korrekt. Batteriet i effektsensorn kan vara tomt. Mer
information finns i bruksanvisningen till effektsensorn.

...Teach new sensor? (Lagga till ny sensor?) visas?

Om du har képt en ny Polar H3 pulssensor, Polar Cadence Sensor W.I.N.D.* eller systemet Polar LOOK
Kéo Power* som tillbehdr, maste den programmeras in pa cykeldatorn. Mer information finns i Anvanda ett
nytt tillbehdr (sida 55).

...hdjden andras dven om jag inte forflyttar mig?

Cykeldatorn omvandlar uppmatt lufttryck till en hdjdavlasning. Det &r darfér som férandringar i
vaderférhallandena (lufttrycket) kan orsaka férandringar i hojdaviasningar.

...hdjdavldsningarna inte ar exakta?

Din héjdmatare kan visa felaktig hdjd om den &r exponerad for yttre stérningar, t.ex. stark vind eller
luftkonditionering. Forsok i sa fall att kalibrera h6jdmataren. Om avlasningarna ar konstant felaktiga
kanske smuts blockerar lufttryckskanalerna. Skicka i sa fall cykeldatorn till en Polar-serviceverkstad.

...Memory low (Lite minne kvar) visas?

fiemory low (Lite minne kvar) visas nar det finns ca 1 timme kvar i minnet. Nar hela minnet har
forbrukats visas Memory Full (Minnet forbrukat). For att frigbra minne fors traningsdata o6ver till
programvaran Polar ProTrainer 5, och raderas fran cykeldatorns minne.
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*Tillbeh6rssensor kravs.

Begransad internationell Polar-garanti

¢ Denna garanti paverkar inte konsumentens lagstadgade rattigheter enligt tillampbara nationella eller lokala
lagar, eller konsumentens rattigheter sa som de ar fastslagna i gallande forsaljningsavtal.

e Den internationella Polar-garantin ar utfardad av Polar Electro Inc. foér de kunder som har inképt denna
produkt i USA eller Kanada. Den internationella Polar-garantin &r utfardad av Polar Electro Oy. fér de
kunder som har inkdpt denna produkt i annat land.

e Polar Electro Inc. / Polar Electro Oy garanterar den ursprunglige kunden / képaren av denna produkt att
produkten ar fri fran produktions- och materialfel i tva ar fran inképsdatum.

e Det ursprungliga inkdpskvittot adr ditt inkopsbevis!

e Garantin tacker inte batterier, skador orsakade av felaktigt anvandande, ovarsamhet, olyckor eller da
foreskrifterna i bruksanvisningen inte uppfylls, felaktigt underhall, kommersiellt anvandande, sprackta
eller trasiga boetter/héljen eller spannband.

e Garantin tacker inte skador, forluster, kostnader eller utgifter; vare sig direkta, indirekta eller oférutsedda,
efterféljande eller specifika, uppkomna av eller relaterade till produkten.

e Artiklar som har kopts i andra hand omfattas inte av garantin pa tva (2) ar, savida inget annat anges i den
lokala lagen.

e Under garantiperioden kommer produkten antingen att repareras eller bytas ut vid ett auktoriserat
servicecenter oavsett inkdpsland.

Garantin for alla produkter begransas till de lander dér produkten ursprungligen har marknadsforts.

C€0337

Denna produkt uppfyller kraven i direktiv 93/42/EEG, 1999/5/EG och 2011/65/EU. Tillamplig Férsakran
om 6verensstammelse finns tillganglig pa www.polar.com/support [http://www.polar.com/support].

X

Den dverkorsade papperskorgen visar att Polars produkter &r elektroniska enheter och omfattas av
Europaparlamentets och Europaradets direktiv 2002/96/EG om avfall fran elektriska och elektroniska
apparater (WEEE). Batterier och ackumulatorer som anvénds i produkter omfattas av Europaparlamentets
och Europaradets direktiv 2006/66/EG fran den 6 september 2006 om batterier och ackumulatorer och
férbrukade batterier och ackumulatorer. Dessa produkter och batterier/ackumulatorer som finns i Polars
produkter ska darfoér kasseras separat i EU-landerna.

R

Denna markning visar att produkten ar skyddad mot elstdtar.

Lagstadgad information finns tillgénglig pa www.polar.com/support [http://www.polar.com/support].
Copyright © 2013 Polar Electro Oy, FIN-90440 KEMPELE, Finland.
Polar Electro Oy ar ett ISO 9001:2008-certifierat foretag.

Med ensamréatt. Ingen del av denna bruksanvisning far anvandas eller kopieras utan skriftligt tillstand fran
Polar Electro Oy. Namn och logotyper i denna bruksanvisning eller i produktlddan ar varumarken som
tillhér Polar Electro Oy. Namn och logotyper som markts med en ®-symbol i denna bruksanvisning eller pa
forpackningen till denna produkt ar registrerade varumarken fran Polar Electro Oy. Windows éar ett
registrerat varumarke som tillhér Microsoft Corporation och Mac OS é&r ett registrerat varumarke som tillhor
Apple Inc.

Polar ansvarsfriskrivning

e Materialet i denna anvandarhandbok tillhandahalls endast i informationssyfte. Produkterna som beskrivs
kan komma att andras utan féregdende meddelande, pa grund av tillverkarens kontinuerliga
utvecklingsprogram.
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e Polar Electro Inc./Polar Electro Oy ger inga garantier vad géller denna anvandarhandbok eller de produkter
som beskrivs hari.

e Polar Electro Inc./Polar Electro Oy har inget ansvar foér skador, forluster, kostnader eller utgifter, direkta,
indirekta eller oférutsedda, efterfoljande eller specifika, uppkomna av, eller relaterade till anvandandet av
detta material eller de produkter som beskrivs hari.

Produkten skyddas av ett eller flera av féljande patent:

US6361502, EP1405594, FI 111514B, DE19781642T1, GB2326240, HK1016857, US6277080,
US20070082789, EP1795128, FI20085432, US12/434143, EP09159601.5, FI114202,
US6537227, EP1147790, HK1040065, FI115289, EP1127544, US6540686, HK1041188, FI
110303, US6104947, EP0748185, JP3831410, EP1694106, US7226321.

Andra patent &r sokta.

Tillverkare:

Polar Electro Oy

Professorintie 5

FI-90440 KEMPELE

Tel +358 8 5202 100

Fax +358 8 5202 300
www.polar.com [http://www.polar.com]

3.0 SWE 09/2013
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